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About Perceptive Intelligent Capture 
Perceptive Intelligent Capture is a product suite designed by Perceptive Software, Inc., to process 
incoming documents automatically. Perceptive Intelligent Capture works with any document that is 
electronically available including scanned images, faxes, e-mails, and files. Perceptive Intelligent Capture 
automatically classifies these documents and extracts meaningful information from them. 

Within the Perceptive Intelligent Capture suite, Perceptive Intelligent Capture Designer enables you to 
customize the automatic processing of incoming documents, for example, which document classes are 
relevant in your enterprise as well as what information to extract from the classified documents. All 
custom settings are saved in a Perceptive Intelligent Capture project file. 

To process large volumes of documents, Perceptive Intelligent Capture organizes documents into 
batches, which are defined in the Perceptive Intelligent Capture project file. The project files and stored 
settings are automatically forwarded to Perceptive Intelligent Capture Runtime Server (PIC Runtime 
Server) for production processing. 

PIC Runtime Server runs unattended as a server process in the background. Several mechanisms 
ensure that the system is stable, meaning that it can automatically recover from most error situations. 
Multiple instances of PIC Runtime Server can be started simultaneously in a network or on a single 
machine. These instances cooperate and allow for optimal load distribution. 

Batches that cannot be automatically processed in their entirety by PIC Runtime Server are forwarded to 
the quality assurance application Perceptive Intelligent Capture Verifier (PIC Verifier) for manual 
correction. 

The PIC Verifier is an application module that allows users to verify documents with no software installed 
on the client side. The Web Verifier application can be used via Internet Explorer on any client machine to 
verify documents. This requires installation and configuration of the project and batches on the database 
platform. It is possible to store project and authentication information in the Perceptive Intelligent Capture 
database. This solution allows for central management of storage and backup and thus provides for 
easier security, better connectivity of your applications, and higher flexibility of your personnel.  

System Requirements 
Operating Systems 
Using Perceptive Intelligent Capture requires a complete and successful installation of the software on a 
server or workstation running one of the following operating systems. 

• Microsoft Windows Server 2008 R2 (IPv4 and IPv6) 

• Microsoft Windows 7 

• VMware ESX 5.1 is certified 
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Perceptive Intelligent Capture Database 
The Web Verifier application module requires central management of project data in a database. The 
Perceptive Intelligent Capture database is certified to run on the following database platforms. 

• Microsoft SQL Server 2008 R2 

• ORACLE 11g R2 

Using Perceptive Intelligent Capture requires .NET Framework 3.5 SP1 installed on the Perceptive 
Intelligent Capture server or workstation. 

IIS 
Using Perceptive Intelligent Capture 5.6 requires the following software applications installed on the 
server. 

• Internet Information Server 

• .NET Framework 3.5 SP1 

For the client browser version side, Internet Explorer 7, 8 and 9 are certified with Perceptive Intelligent 
Capture 5.6 application. 

Scripting components 
Perceptive Intelligent Capture is certified for the following supported Scripting component version. 

• WinWrap version 9.0.0.56 

Hardware Requirements 
Before you can implement Perceptive Intelligent Capture, the underlying network must meet certain 
minimum platform and environment requirements.  

This section includes information about, and instructions for, configuring basic network components.  

Network Infrastructure 
The technology infrastructure underlying Perceptive Intelligent Capture consists of a set of scalable 
applications and services running on Microsoft Windows operating systems. These applications and 
services are deployed on a set of high-performance Intel-compatible servers and workstations. 

Clients are supported on Intel-compatible workstations running Windows 7.  

Perceptive Intelligent Capture is a distributed, two-tier application that is typically deployed across 
multiple Windows Server operating systems. These applications provide core system services when 
connected using an unimpeded high-speed, low-latency network infrastructure, such as Fast Ethernet 
(100BaseTX), using TCP/IP. 

Hardware and Software Factors 
When implementing a Perceptive Intelligent Capture Project, there are a number of dependencies that 
influence the hardware requirements for a Perceptive Intelligent Capture solution.  

Use the hardware requirements provided in this document as a guideline; it is not a recommended or 
required hardware configuration for an implementation of Perceptive Intelligent Capture. The actual 
hardware and software configuration for an installation is based on the client’s requirements. 
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When sizing the hardware for a production environment, consider the following factors. 

• Input volume. The number of documents and pages to process on a daily basis. 

• Completion Time. The required amount of time from when the document is scanned into the system 
to when it is exported out of Perceptive Intelligent Capture. 

• Complexity of input documents. This includes single or multi-page TIFF, scanned resolution, 
document size, number of pages OCR’ed per document, and more. 

• Output requirements. This includes data extraction, validation, and export, number of documents 
processed per day, and more. 

• Complexity of workflow customization. This includes, but is not limited to scripting. 

• Third-party software integration requirements. This includes third-party software such as Oracle 
Financials, JD Edwards, SAP, CRM systems, and so on. 

• Backup strategy.  

• Disaster recovery. This includes backup, fault tolerance, up time, and more. 

• Network operating system platform. 

• Network environment. 

• Room for growth. This includes increased in input and output and other system requirements. 

• Users. This includes the number of users such as those using Web Verifier versus Verifier. 

• Batch Retention Time. This is the retention time for a batch of documents to remain in the system 
after export. 

• Number of projects. This is the number of Perceptive Intelligent Capture projects per country, per 
solution, and so on. 

• Components Installed. Other Perceptive components such as WF-Perceptive Intelligent Capture 
and Visibility or databases would likely be installed on another server. It is recommended that for a 
production environment, that you install Perceptive products on separate servers. 

The following sections of the document are representations of some hardware scenario configuration. 

Hardware Estimate – 500 PPD 

Introduction – AP Project 
Based on the standard Perceptive AP Project, the following production system is recommended. 

• 1-3 page TIFF documents 

• Document resolution of 300 dpi 

• Average TIFF size of approximately 40KB 

• Average WorkDoc size of approximately 21KB 

• Minimum data extraction and validation (as per the project) 

• Project size of less than 5 MB and less than 10 classes 

• Cleanup of exported batches (1-3 days) 
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Note Disk space requirement is implementation dependent; variables such as document complexity, 
scanned resolution, and document volume help determine the amount of disk space for a project. For 
example, persistent storage of TIFF images requires approximately 70 KB per page. In addition, 
approximately 100 KB per document are required to store WorkDocs with OCR results temporarily. If PDF 
file generation is enabled, another 100 KB per page are temporarily required. 
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Hardware Estimate 
This table provides the recommended configuration for the systems. The table excludes Web Verifier and 
database estimates.  

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server 
(Primary) 

• File Repository 

• OCR/Classify/E
xtract 

• Licensing 
Server 

 

Required Dual Core Xeon 
Class, 2.8 GHz 
CPU 

4 GB RAM 

20-40Gb Hard Disk 
Space 

Perceptive 
Licensing Dongle 

Windows 2008 R2 with the latest service pack 

Perceptive Intelligent Capture Version 5.6 

Perceptive Intelligent 
Capture Designer 

Project Design 

Class Training 

Optional Pentium IV Class, 
2.4 GHz CPU (2.8 
GHz recom-
mended) 

1 GB RAM 

10 GB hard drive 
(20 GB hard drive 
recommended) 

Windows 7  

Perceptive Intelligent Capture Designer Version 5.6 

Perceptive Intelligent 
Capture Verifier, 
Advanced Verifier & 
Learnset Manager 

Data Verification 

Required Pentium Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive 
(10 GB minimum) 

Windows 7  

Perceptive Intelligent Capture Verifier Version 5.6 

Perceptive Intelligent 
Capture Remote 
Admin 

RTS Remote 
Administration 

Optional Pentium Class, 2.4 
GHz 

1 GB RAM 

[HD – Application 
install only  
<500Mb] 

Windows 7  

Perceptive Intelligent Capture Version 5.6 

RTS Remote Admin MMC Snap-in 
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Hardware Estimate – SQL Server Database (Excl. Web Verifier) 

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server (Primary) 

• File Repository 

• OCR/Classify/Extract 

• Licensing Server 
 

Database Server 

Required Quad Core Xeon 
Class, 2.8 GHz CPU 

4 GB RAM 

100Gb Hard Disk 
Space 

Perceptive Licensing 
Dongle 

Windows 2008 R2 with the latest service 
pack 

SQL Server 2008 R2 or ORACLE 10 and 
above 

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

Perceptive Intelligent 
Capture Designer 

Project Design 

Class Training 

Optional Pentium IV Class, 
2.4 GHz CPU (2.8 
GHz recommended) 

1 GB RAM 

10 GB hard drive (20 
GB hard drive 
recommended) 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Designer 
Version 5.6 

Perceptive Intelligent 
Capture Verifier, 
Advanced Verifier & 
Learnset Manager 

Data Verification 

Required Pentium Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive (10 
GB minimum) 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Verifier 
Version 5.6 

Perceptive Intelligent 
Capture Remote Admin 

RTS Remote 
Administration 

Optional Pentium Class, 2.4 
GHz 

1 GB RAM 

[HD – Application 
install only  <500Mb] 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

RTS Remote Admin MMC Snap-in 

Note  When using ORACLE as a database, it is advised to have an ORACLE client installed on any 
workstation/server where Perceptive Intelligent Capture communicates with the database (Designer, 
Verifier, etc). 
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Hardware Estimate – Entire Application Suite 
The entire application suite is Perceptive Intelligent Capture Runtime Server, Web Server, and Database. 

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server (Primary) 

• File Repository 

• OCR/Classify/Extract 

• Licensing Server 

 

Database Server 

 

Web Server 

Required Quad Core Xeon 
Class, 2.8 GHz CPU 

8 GB RAM 

100Gb Hard Disk 
Space 

Perceptive Licensing 
Dongle 

Windows 2008 R2 with the latest service 
pack 

SQL Server 2008 R2 or ORACLE 10 and 
above 

Perceptive Intelligent Capture Designer 

IIS 6 and above 

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

Perceptive Intelligent 
Capture Designer 

Project Design 

Class Training 

Optional Pentium IV Class, 
2.4 GHz CPU (2.8 
GHz recommended) 

1 GB RAM 

10 GB hard drive (20 
GB hard drive 
recommended) 

Windows 7  

 .NET Framework 3.5 SP1 

Perceptive Intelligent Capture Designer 
Version 5.6 

Perceptive Intelligent 
Capture Verifier, 
Advanced Verifier & 
Learnset Manager 

Data Verification 

Optional Pentium Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive (10 
GB minimum) 

Windows 7  

 .NET Framework 3.5 SP1 

Perceptive Intelligent Capture Verifier 
Version 5.6 

Perceptive Intelligent 
Capture Web Verifier 

Optional Pentium Class, 2.4 
GHz 

2GB RAM 

 

Windows 7  

Internet Explorer 8 

Perceptive Intelligent 
Capture Remote Admin 

RTS Remote 
Administration 

Optional Pentium Class, 2.4 
GHz 

1 GB RAM 

[HD – Application 
install only  <500Mb] 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

RTS Remote Admin MMC Snap-in 
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Hardware Estimate – Typical Development Environment 
A typical development environment consists of one server that processes less than 500 pages per day. 
The specification below should be sufficient to house the Web Server, Database, and Perceptive 
Intelligent Capture Runtime Server. 

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server (Primary) 

• File Repository 

• OCR/Classify/Extract 

• Licensing Server 

 

• Database Server 

• Web Server 

Required Quad Core Xeon 
Class, 2.8 GHz CPU 

8 GB RAM 

100Gb Hard Disk 
Space 

Perceptive Licensing 
Dongle 

Windows 2008 R2 with the latest service 
pack 

SQL Server 2008 R2 or ORACLE 10 and 
above 

 

IIS 6 and above 

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Designer 

Perceptive Intelligent Capture Version 5.6 
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Hardware Estimate – 4000 PPD 

Introduction – AP Project 
Based on the standard Perceptive AP Project, the following production system is recommended. 

Assumptions: 

• 1-3 page TIFF documents 

• Document resolution of 300 dpi 

• Average TIFF size of approximately 60KB 

• Average WorkDoc size of approximately 60KB 

• Minimum data extraction and validation (as per the project) 

• Project size of less than 5 MB and less than 10 classes 

• Cleanup of exported batches (1-3 days). 

• All documents are provided at the start of the day 

Disk space requirement is implementation dependent; variables such as document complexity, scanned 
resolution, and document volume help determine the amount of disk space for a project. For example, 
persistent storage of TIFF images requires approximately 70 KB per page. In addition, approximately 100 
KB per document are required to store WorkDocs with OCR results temporarily. If PDF file generation is 
enabled, another 100 KB per page are temporarily required. 

Hardware Estimate – File System (Excl. Web Verifier & Database) 

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server (Primary) 

• File Repository 

• OCR/Classify/Extract 

• Licensing Server 

 

Required Quad Core Xeon 
Class, 2.8 GHz CPU 

8GB RAM 

200Gb Hard Disk 
Space 

Perceptive Licensing 
Dongle 

Windows 2008 R2 with the latest service 
pack 

Perceptive Intelligent Capture Version 5.6 

Perceptive Intelligent 
Capture Designer 

Project Design 

Class Training 

Optional Pentium IV Class, 
2.4 GHz CPU (2.8 
GHz recommended) 

1 GB RAM 

10 GB hard drive  
hard drive 
recommended) 

Windows 7  

Perceptive Intelligent Capture Designer 
Version 5.6 

 



 

Percep t i ve  In te l l i gen t  Cap tu re  Ins ta l l a t ion  and  Se tup  Gu ide  

Page 16 of 2 

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Verifier, 
Advanced Verifier & 
Learnset Manager 

Data Verification 

Required Pentium Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive (10 
GB minimum) 

Windows 7  

Perceptive Intelligent Capture Verifier 
Version 5.6 

Perceptive Intelligent 
Capture Remote Admin 

RTS Remote 
Administration 

Optional Pentium Class, 2.4 
GHz 

1 GB RAM 

[HD – Application 
install only  <500Mb] 

Windows 7 Perceptive Intelligent Capture 
Version 5.6 

RTS Remote Admin MMC Snap-in 

Hardware Estimate – SQL Server Database (Excl. Web Verifier)  

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server (Primary) 

• File Repository 

• OCR/Classify/Extract 

• Licensing Server 

 

Database Server 

 

Required Quad Core Xeon 
Class, 2.8 GHz CPU 

8 GB RAM 

200Gb Hard Disk 
Space 

Perceptive Licensing 
Dongle 

Windows 2008 R2 with the latest service 
pack 

SQL Server 2008 R2 or ORACLE 10 and 
above 

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

Perceptive Intelligent 
Capture Designer 

Project Design 

Class Training 

Optional Pentium IV Class, 
2.4 GHz CPU (2.8 
GHz recommended) 

1 GB RAM 

10 GB hard drive (20 
GB hard drive 
recommended) 

Windows 7  

 .NET Framework 3.5 SP1 

Perceptive Intelligent Capture Designer 
Version 5.6 

Perceptive Intelligent 
Capture Verifier, 
Advanced Verifier & 
Learnset Manager 

Data Verification 

Required Pentium Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive (10 
GB minimum) 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Verifier 
Version 5.6 
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Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Remote Admin 

RTS Remote 
Administration 

Optional Pentium Class, 2.4 
GHz 

1 GB RAM 

[HD – Application 
install only  <500Mb] 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

RTS Remote Admin MMC Snap-in 

When using ORACLE as a database, it is advised to have an ORACLE client installed on any 
workstation/server where Perceptive Intelligent Capture communicates with the database (Designer, 
Verifier, etc). 

Hardware Estimate – Entire Application Suite 
The entire application suite comprises of Perceptive Intelligent Capture Runtime Server, Web Server, and 
Database. 

Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Server (Primary) 

• File Repository 

• OCR/Classify/Extract 

• Licensing Server 

Database Server 

 

 

Required Quad Core Xeon 
Class, 2.8 GHz CPU 

8 GB RAM 

100Gb Hard Disk 
Space 

Perceptive Licensing 
Dongle 

Windows 2008 R2 with the latest service 
pack 

SQL Server 2008 R2 or ORACLE 10 and 
above 

IIS 6 and above 

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture  Version 5.6 

Perceptive Intelligent 
Capture Web Server 

Required Dual Core Xeon 
Class, 2.8 GHz CPU 

4 GB RAM 

50Gb Hard Disk 
Space 

30Gb OS Hard Disk 
Space 

Windows 2008 R2 with the latest service 
pack 

SQL Server 2008 R2 or ORACLE 10 and 
above 

Perceptive Intelligent Capture Designer 

IIS 6 and above 

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

Perceptive Intelligent 
Capture Designer 

Project Design 

Class Training 

Optional Pentium IV Class, 
2.4 GHz CPU (2.8 
GHz recommended) 

1 GB RAM 

10 GB hard drive (20 
GB hard drive 
recommended) 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Designer 
Version 5.6 
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Machine Role  Hardware Software Needed 

Perceptive Intelligent 
Capture Verifier, 
Advanced Verifier & 
Learnset Manager 

Data Verification 

Optional Pentium Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive (10 
GB minimum) 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Verifier 
Version 5.6 

Perceptive Intelligent 
Capture Web Verifier 

Optional Pentium Class, 2.4 
GHz 

2GB RAM 

 

Windows 7  

Internet Explorer 8 

Perceptive Intelligent 
Capture Remote Admin 

RTS Remote 
Administration 

Optional Pentium Class, 2.4 
GHz 

1 GB RAM 

[HD – Application 
install only  <500Mb] 

Windows 7  

.NET Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

RTS Remote Admin MMC Snap-in 

Web Verifier Server Hardware Sizing – Additional Information 
Additional Web Server considerations depend on the number of Verifier users. 

Number of Users Memory Processor 

Per User 150Mb Peak Load 100% of a 3GHz CPU 

0-10 Users 4 Gb Dual Core CPU 

11-20 Users 8 Gb Quad Core CPU 
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Factors that influence the metrics are listed below. 

• Project size and complexity 

• Other software stored on the server 

• Third party software integration  

• Network connections 

• Document Sizes 

• Project Type 

Machine Role Hardware Software Needed 

Perceptive 
Intelligent Capture 
Server (Primary) 

Project File (.SDP) 

Batch Directory 

Stores Images 

Workdocs 

Input Directory 

Learnset 

License Server 

Xeon Class, 2.4 GHz 
CPU 

2 GB RAM 

Three or more 36 GB (40 
GB recommended) + Hot 
Swappable hard drive 

RAID Controller (for fault 
tolerance) 

Dongle 

Windows 2008 R2 with the latest service pack 

Microsoft .Net Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

Perceptive 
Intelligent Capture 
RTS 

Performs OCR 

Classification 

Data Extraction 

Export 

System Clean-up 

Dual Xeon Class, 2.8 
GHz CPU 

2 GB RAM (1 GB 
minimum) 

40 GB hard drive 

Windows 2008 R2 with the latest service pack 

Microsoft .Net Framework 3.5 SP1 

Perceptive Intelligent Capture Version 5.6 

Perceptive 
Intelligent Capture 
Designer 

Project Design 

Class Training 

Pentium IV Class, 2.4 
GHz CPU (2.8 GHz 
recommended) 

1 GB RAM 

10 GB hard drive (20 GB 
hard drive 
recommended) 

{xe Windows 7} Windows 7, or Windows 2008 R2  

Microsoft .Net Framework 3.5 SP1 

Perceptive Intelligent Capture Designer Version 5.6 
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Machine Role Hardware Software Needed 

Perceptive 
Intelligent Capture 
Verifier, Advanced 
Verifier & Learnset 
Manager 

Data Verification 

Pentium Class, 2.4 GHz 
CPU (2.8 GHz 
recommended) 

1 GB RAM 

20 GB hard drive (10 GB 
minimum) 

{xe Windows 7} Windows 7, or Windows 2008 R2  

Microsoft .Net Framework 3.5 SP1 

Perceptive Intelligent Capture Verifier Version 5.6 

Perceptive 
Intelligent Capture 
Remote Admin 

RTS Remote 
Administration 

Pentium Class, 2.4 GHz 
CPU (2.8 GHz 
recommended) 

1 GB RAM 

10 GB hard drive 

Windows 7, or Windows 2008 R2  

Perceptive Intelligent Capture Version 5.6 

RTS Remote Admin MMC Snap-in 

Perceptive 
Intelligent Capture 
Web Verifier Server 

 

Pentium Class, 2.4 GHz 
CPU (2.8 GHz 
recommended) 

1 GB RAM 

10 GB hard drive 

{xe Windows 7} Windows 7, or Windows 2008 R2  

Microsoft .Net Framework 3.5 SP1 

Internet Information Server (IIS) 6.0 or higher 

Perceptive Intelligent Capture Version 5.6 
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Infrastructure Constraints 
Perceptive Intelligent Capture has been fully tested and is certified to work in most LAN environments. By 
adhering to the following infrastructure constraints, you can ensure a smooth implementation of the 
product suite. 

OCR Performance 
OCR is a processor-intensive task. To maximize OCR performance, we recommend that only one RTS 
OCR instance is active per CPU on a production server. Although it is possible to run multiple RTS OCR 
instances on a single CPU, doing so may impair the performance of OCR and the overall system. 

Firewalls 
Perceptive Intelligent Capture is designed to work in a non-encapsulated LAN environment. A non-
encapsulated LAN, in this context, is a LAN segment free of impediments such as firewalls and other 
traffic-filtering devices.  

With multi-site network environments, it is the responsibility of the customer’s IT personnel to ensure that 
an unobstructed communication path exists between the user community and host system. 

RTS Remote Administration MMC 
You can remotely administer Perceptive Intelligent Capture Runtime Server, meaning that you can 
centrally manage multiple Runtime Servers from a single workstation on the network using a 
management console snap-in called the RTS Remote Administration MMC. 

However, to use the RTS Remote Administration MMC snap-in, the administrator workstation must either 
reside on the same LAN segment as the RTS server services to be centrally administered or, in the case 
of a sub-netted network, a name resolution system must be in place to allow clients on one subnet to 
locate resources on another subnet.  

Remote Administration by MMC requires one free configurable port number. The default port is 50607. 

The Windows service Perceptive Intelligent Capture Service Manager must be running to be able to 
connect by MMC to the Runtime Server service. Once the service is running, it is possible to start and 
stop each Runtime Server instance separately. 

As long as the configured port is available in any TCP/IP network (or Internet across firewalls) and the 
main service is running, the MMC can be used to configure and maintain the Runtime Server instances. 
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Installation prerequisites of Perceptive Intelligent Capture 
When you are ready to install Perceptive Intelligent Capture, there are several steps you should take to 
ensure that the installation goes smoothly. This section includes the following information. 

• Backward compatibility with other Perceptive applications 

• Upgrading from previous versions of Perceptive Intelligent Capture 

• Uninstalling Perceptive Intelligent Capture Versions 4.x 

• Installing Perceptive Intelligent Capture Version 5.6 in standalone mode 

• Installing Perceptive Intelligent Capture Version 5.6 

• Checking the installation 

• Migrating existing project files to Version 5.6 

• Uninstalling Perceptive Intelligent Capture Version 5.6 

• Repairing Perceptive Intelligent Capture Version 5.6 

• Adding or removing product components 

Before Installing Perceptive Intelligent Capture 
Before starting the installation, make sure that you have local administrator rights on the target machine. 
During the installation, a number of DLLs will be copied to the Windows system directory and registered 
with the operating system. The Perceptive Intelligent Capture database will be created on the SQL Server 
or ORACLE servers. The install process requires administrative privileges and access to the Windows 
registry.  

The installation media contains the following folders: 

• .\Install contains the setup executables of the Perceptive Intelligent Capture product suite. 

• .\Install\doc contains Perceptive Intelligent Capture product documentation. 

Installation Checklist 
The checklist below is designed to help you install and configure Perceptive Intelligent Capture in your 
environment.  

 If you are installing Perceptive Intelligent Capture in standalone mode, such as for a non-
network test or demo installation, only complete the steps outlined in Install Perceptive 
Intelligent Capture. You can skip the rest of the installation checklist. 

 If you are upgrading from a previous version of Perceptive Intelligent Capture, review and 
complete the Upgrade from Previous Versions section before continuing with the installation 
checklist.   
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Upgrade from Previous Versions 
 If your organization uses other Perceptive products, read the Backward Compatibility with 

Other Perceptive Applications section before proceeding with the installation checklist. 
 Read Hardware Requirements. 
 Configure the SQL Server / ORACLE software. 
 If following the Microsoft recommended resource rights assignment model, create the users 

and groups. 
 Install Perceptive Intelligent Capture version 5.6. (Install Perceptive Intelligent Capture) 
 Configure the Runtime Components. (Configure Runtime Components) 
 Configure the Runtime Service Manager (Section Configure the Runtime Service Manager). 
 Start the Runtime Service Manager. 
 Configure the RTS RemoteAdmin MMC snap-in (Section Configure the RTS RemoteAdmin 

MMC Snap-in). 
 Test the installation (See the Perceptive Intelligent Capture Runtime Server User Guide).  
 Configure license and project settings for an instance. (See the Perceptive Intelligent Capture 

Runtime Server User’s Guide.) 
 Process a batch (minimum workflow steps: OCR, Classification, and Extraction). 
 If using Web Verifier, configure the IIS and .NET along with application security. (See 

Configure Application) 

Backward Compatibility with Other Perceptive Applications 
Perceptive Intelligent Capture is part of the Perceptive line of application suites branded Perceptive. 
These products share common components based on the award-winning Perceptive technology.  

This version of Perceptive Intelligent Capture is completely based on the Database platform. Support of 
the file system has been discontinued. 

If your organization uses Capture (in conjunction with older versions of Perceptive Intelligent Capture) 
and you want to upgrade to Perceptive Intelligent Capture Version 5.6, you may keep on using the older 
version of Capture on a separate machine and use the RTS image import method. Capture is not 
available in this version of Perceptive Intelligent Capture and cannot be installed/used on the same 
machine. 

Note Perceptive recommends engaging Professional Services to ensure a successful and smooth 
installation of the software. 

Perceptive Intelligent Capture License File 
Perceptive Intelligent Capture version 5.6 requires a new license file. Contact Perceptive Customer 
Support to convert your existing license to a version 5.6 license file. 

Perceptive Intelligent Capture Database Checklist 

Perceptive Intelligent Capture Database 
Perceptive Intelligent Capture version 5.6 is able to store the following Perceptive Intelligent Capture core 
information directly in the Perceptive Intelligent Capture database, instead of the file system: 

• Documents 

• Batches (jobs) 

• Images and document files in e-format 
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• Project references 

• Users, groups, roles and relationships 

• Verifier configuration (Web Verifier only) 

• Batch/Document lock handling 

• Application level user licensing 

File system functionality is no longer supported. Customers with file system based batches that want to 
upgrade to the new version will be required to upgrade to database based batches. 

Prior to installation of Perceptive Intelligent Capture, some care must be taken to make sure that the 
appropriate configuration steps have been taken. 

Perceptive Intelligent Capture SQL Server Checklist 
Perceptive Intelligent Capture will need to create the following items prior to the installation of the 
software: 

1. An administrative database account with rights to create, modify, and delete tables. Windows 
Authentication can be used if the user performing the installation has administrative rights to the 
database server. 

2. A designated user database account which will be used by Perceptive Intelligent Capture to access 
the database, add, modify, and delete data. Windows Authentication can be used if the user 
performing the installation has the appropriate rights to the database server. 

Perceptive Intelligent Capture ORACLE Checklist 
Perceptive Intelligent Capture will need the following items taken care of prior to the installation of the 
software: 

1. Create a new ORACLE instance for Perceptive, give it a name, such as Perceptive Intelligent 
Capture. 

2. Create a new user called Perceptive with a password. 

3. Assign sufficient rights to the above user: 

a. Allow for increased growth of data. 

b. Allow for insertion, modification, and deletion of data. 

c. Allow for table, views, etc. creation. 

4. Administrative database accounts with rights to create, modify, and delete tables. Windows 
Authentication can be used if the user performing the installation has administrative rights to the 
database server. 

5. A designated user database account which will be used by Perceptive Intelligent Capture to access 
the database, add, modify, and delete data. Windows Authentication can be used if the user 
performing the installation has the appropriate rights to the database server. 
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Upgrade from Previous Versions 

Perceptive Intelligent Capture Versions 1.3.x and 2.x 
The earlier versions of Perceptive Intelligent Capture, 1.3.x and 2.x, require Professional 
Services/Perceptive assistance in upgrading as there have been several changes in the software 
architecture. 

Upgrade from Version 5.3 or later versions 
The installation process provides a Repair option to upgrade version 5.3 or later versions to 5.6. For 
details, refer to the Product Migration Guide. 

Upgrade from versions prior to 5.3 
Due to the Perceptive Intelligent Capture database focusing from version 5.3 on which has to be 
established during the setup process, Perceptive Intelligent Capture versions previous to 5.3 must be 
uninstalled prior to installation of version 5.6. 

Remove Perceptive Intelligent Capture Versions 3.0, 4.0, and 4.1 
It is recommended to uninstall any previous versions of Perceptive Intelligent Capture prior to installing 
Perceptive Intelligent Capture 5.6. 

The uninstaller may not remove several registry entries and subdirectories adequately. For this reason, 
they must be removed manually. Follow the procedure below to remove the older version of Perceptive 
Intelligent Capture before installing Version 5.6. 

Important Follow these instructions to remove some of the files and registry entries that are used by 
other Perceptive products and render the products unusable. If you already have other Perceptive 
products installed, expand the affected folders and registry keys and delete only the subfolders and sub-
registry values that are specific to Perceptive Intelligent Capture. 

To remove previous versions of Perceptive Intelligent Capture, complete the following steps. 

1. Select Start > Settings > Control Panel. 

2. Launch the Add/Remove Program wizard. 

3. On the Currently Installed Programs list, select the Perceptive Intelligent Capture version you want 
to remove. 

4. Click Change/Remove. 

5. Follow the on-screen instructions to remove the product. 

6. Click Finish. 

7. Save any permanent license files in the …\<Application folder>\Component\Cairo directory before 
deleting the …\<Application folder> folder.  

If there are other Perceptive products installed, do not delete the …\Cairo and …\Cedar sub-
directories or any registry keys specific to those applications. Also, if there are any project files 
stored below the …\<Application folder> folder, you should move them before deleting the folder. 
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8. Remove the …\<Application folder> subdirectory. 

9. Restart the machine. 

10. Install Perceptive Intelligent Capture Version 5.6. 

Note Perceptive Intelligent Capture Runtime Server Settings and Verifier Settings files can be reused in 
the new version. It is recommended to save these prior to un-installation and reuse them when 
configuring a new Runtime Server or Verifier Workstation. 

Install Perceptive Intelligent Capture 
Software Installation 
Note You must first install .NET Framework 3.5 SP1 prior to installing Perceptive Intelligent Capture. 

To install Perceptive Intelligent Capture, complete the following steps.  

1. Browse to the installation folder and run setup.exe.  

2. English and German are the supported installation languages. The installer gets its language settings 
from the regional settings of the operating system. The installation defaults to English if a language 
other than English or German is detected. 

3. Make sure that all Perceptive Intelligent Capture applications are closed. 

4. Click Next to continue. 

5. Read and confirm the End-User License Agreement (EULA). You need to agree to the license 
agreement to proceed with the installation. The EULA file is available in 10 languages. The setup 
auto-detects your local regional settings and presents the appropriate EULA file. If none of the 10 
languages matches your regional settings, the English version is selected by default. 

6. Select the installation type: Complete or Custom 

• Complete.  Installs the most common options of Perceptive Intelligent Capture Designer, 
Runtime Server, and Thick/Web Verifier. 

OCR Engines FineReader 10, FineReader 11, Kadmos 5, Recognita, QualitySoft, and Cleqs 
Barcode. 

Default Folder.  SystemDrive:\Program Files\Perceptive. 
Default Program Group.  Perceptive Intelligent Capture. 

• Custom.  It enables you to install only the components you will use. 

7. For a complete installation, choose Complete and click Next. This will run the typical installation and 
install all optional components. Refer to the Program Folder and Auto Update section to complete 
the setup. By default, the Demo License is included. 

8. For a custom installation, choose Custom and click Next. Read the next chapter for details. 
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Select Custom Installation 
If you selected Custom on the Setup Type screen, you can select the installation directory, the features, 
and other components. 

For a custom installation, complete the following steps. 

1. Select the installation directory. 

2. In the Feature Selection dialog box, select the desired applications. 

3. In the OCR components list, you can select the optional components used for Barcode recognition 
and Handprint OCR.  
Note  Only components selected during the installation are available. For information on adding 
components after the installation,  refer to the Add or Remove Version 5.6 Components section. 

4. Make the selection for the Demo Project.  

5. Click Next. 

Note Optional components must be acquired separately and require separate licensing. 

Optional components 

Cleqs Barcode 
Engine:  

Reads handwritten and machine-printed data and barcode information. It reads 18 
types of barcodes. 

FineReader10 OCR 
Engine: 

Supporting Chinese/Korean/Japanese characters in addition to English, German, 
Italian, French, and Spanish. Converts paper-based or scanned images into editable 
text.  

FineReader11 OCR 
Engine: 

The FineReader11 engine is fully integrated and supports OCR of several additional 
languages. The FineReader 11 engine features a number of general improvements in 
the quality of OCR output relative to the FineReader 10 engine: 

• Receipt Mode,  

• improved auto-orientation,  

• improved OCR of amounts with leading/trailing asterisks,  

• improved OCR of amount with leading dollar sign $. 

Kadmos5 OCR 
Engine:  

Used for handwriting recognition. 

Recognita Engine:  Supports 75 languages and more than 100 scanner models. 

QualitySoft Barcode 
Engine 

Support grayscale and color images. QualitySoft recognizes 19 different barcode 
types. 
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Program Folder and Auto Update 
For either a typical or a custom installation, complete the following steps. 

1. Select the desired applications for the Auto Update Feature. You can enter the path for the Shared 
Network Updates Directory here. 

2. Click Next. 

3. In the Select Program Folder screen, select an existing program folder or a new folder for the 
Perceptive Intelligent Capture program icons. The default setting is Perceptive\Perceptive Intelligent 
Capture. 

4. Click Next. 

Finish Typical and Custom Installations 
1. Verify that the selected components are listed on the Selected Install Options dialog box and click 

Next. 

2. At the WIBU-KEY Runtime-Kit pop-up window, click Yes to install the  
Runtime-Kit. 

3. The setup creates several subdirectories below the installation directory: 

• \Components\Cairo contains the Perceptive base components for imaging and recognition. In a 
complete installation, there are several subdirectories with third party libraries: Accusoft, Cleqs 
Barcode, FineReader, Kadmos, Recognita, and LDF. This directory also contains the master 
license file. 

• \Components\Cedar contains the Perceptive base components for document analysis. There is 
one subdirectory for each supported language and a subdirectory with a third party library, 
FindLink. 

• \Components\Tools contains the installation log file, component version information, and other 
tools/utilities for Perceptive Intelligent Capture. 

• \Projects contains demo projects.  

• \Perceptive Intelligent Capture\bin contains the Perceptive Intelligent Capture Designer 
executable DstDsr.exe, the Perceptive Intelligent Capture Runtime Server executables 
DstMgr.exe and DstHost.exe, the Perceptive Intelligent Capture Supervised Learning Manager 
executable DstSlm.exe, and the Perceptive Intelligent Capture Verifier executable DstVer.exe. It 
also contains the settings files.  

• \Perceptive Intelligent Capture\bin\Log contains the log files of the Perceptive Intelligent Capture 
Runtime Server. 

• \Perceptive Intelligent Capture Web Server contains the Perceptive Intelligent Capture Web 
components, the Web.Config file, and other web libraries used by the Web Verifier. 

If you want to end the installation without installing the Database, go to the Complete the Perceptive 
Intelligent Capture Setup section. 
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Perceptive Intelligent Capture Database Setup 
To complete the database setup, complete the following steps.  

1. Select SQL Server or Oracle and click Next.  

2. Provide administrative login credentials. This will need to be an account, which has access to create 
databases, tables, views, and so on in the database instance. 

3. Enter the name of your Database server. The setup searches for the Database Server, connects with 
it,  and creates a new database on it. 

• SQL Server: DatabaseServerName[\InstanceName] 

• Oracle: DatabaseServerName\InstanceName  
 

Note If you already have a Perceptive Intelligent Capture Database installed, that Database will be 
overwritten by this installation process. In that case, a notification would be displayed to remind you of 
deletion: 

A Perceptive Intelligent Capture Database has been detected. 

If you continue the Database will be overwritten. 

It is strongly recommended that the existing Database be backed up before 
continuing. 

If you want to save your existing Database, back it up before continuing. This applies for the installation of 
a new version on the same machine.  

If you want to keep your current installation but want to install Perceptive Intelligent Capture, for example 
on an additional Runtime Server machine, you can keep your existing Database by copying all of the 
configuration files (web.config and .config files in \Perceptive Intelligent Capture\bin) from the existing 
installation folder Perceptive Intelligent Capture\bin to the new setup folder. 

4. Enter your logon information for the Database or use Windows Authentication. The login credentials 
need to have Read/Write/Execute access to the newly created Database.  

5. Click Next. 
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Complete the Perceptive Intelligent Capture Setup 
1. The final part of the installation confirms components that have been installed.  

2. Select Next to continue.  

3. You are presented with a screen to confirm if you want to have desktop icons created for Perceptive 
Intelligent Capture application. Select the check box if you want desktop icons.  

4. Select Finish to complete the installation. 

Note  In version 5.6, the French language is supported for Verifier, Web Verifier, and Learnset Manager. 
To enable the French language, select the language on the Formats tab of your system’s Regional and 
Language Options. 

Manually Create Database Objects (post install)  
It is also possible to install the database manually. This can be due to corporate policies. To install and 
configure the database manually, complete the following steps. 

1. Launch Windows Explorer and navigate to the installation folder. Navigate to 
<installerFolderLocation>\FirstPart\Database\CreationScripts.  There are two folders, SQL 
Server and ORACLE. Each folder contains database scripts you execute to create the tables, views, 
indexes, and default data values. 

2. Open the database configuration panel. 

• SQLServer: Management Console.  

1. Log into the database with Administrator rights. 

2. Create a new database. 

3. Run the SQL scripts to create the appropriate values. 

• ORACLE: SQLPlus or ORACLE Management Console 

1. Follow the steps outlined earlier in this document in configuring the database prior to 
ORACLE installation. For more information, refer to the Perceptive Intelligent Capture 
ORACLE Checklist section. Log into the database with user account where the tables will be 
located. 

2. Run the database script to create the appropriate values. 

3. Navigate to <installerFolderLocation>\FirstPart\Database\UpdateScripts 
Again, you will find folders for the SQL and the Oracle scripts. 

4. Edit the Update Database script. 

• in Oracle script: TargetDBSchemaName 

• in MS SQL script: TargetDatabaseName 

Note If you refrain from executing the steps outlined above, an error message will turn up on 
running of the Update Scripts. 

5. Run the Update Database script. 

6. Check that the database tables have been created correctly and no errors were reported on 
execution of the database scripts. 

7. There are several configuration components that require modification. Navigate to the Perceptive 
installation folder. By default this is located in Program Files\Perceptive. 
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8. Navigate to the Perceptive Intelligent Capture Web Server folder and open the Web.config file in 
Notepad. 

9. Search for the connection string in the file. 
 <connectionStrings></connectionStrings> 

10. Modify the connection string to connect to the database. 

SQLServer Example 
<connectionStrings> 

<add name="Entities" 
connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entities.ssd
l|res://*/Entity.Entities.msl; provider=System.Data.SqlClient;provider connection 
string=&quot;Data Source=DBINSTANCE\SQLEXPRESS;Initial 
Catalog=SQLServerDatabaseCatalog;Integrated Security=false;User 
ID=Perceptive;Password=Perceptive;MultipleActiveResultSets=True&quot;" 
providerName="System.Data.EntityClient" /> 

  </connectionStrings> 

Oracle Example 
<connectionStrings> 

<add name="Entities" 
connectionString="metadata=res://*/Entity.ORAEntities.csdl|res://*/Entity.ORAEntiti
es.ssdl|res://*/Entity.ORAEntities.msl; provider=EFOracleProvider; Provider 
Connection String='Data Source=OracleServerName;User 
Id=Perceptive;Password=Perceptive'" providerName="System.Data.EntityClient" /> 

</connectionStrings> 

11. Navigate to the \Perceptive Intelligent Capture\bin folder. 

12. Repeat the previous steps to update the connection strings in each of the following configuration files. 

• DstDsr.exe.config 

• DstHost.exe.config 

• DstSlm.exe.config 

• Brainware.System.Project.config 

• DstVer.exe.config 

• DstWkBrw.exe.config.  
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13. For ORACLE installation, it is required to make one more addition to the .NET installation for the 
ORACLE connection string above to work. 

1. Navigate to the Windows folder using Windows Explorer 

2. Navigate to WINDOWS\Microsoft.NET\Framework\ v2.0.50727\CONFIG. 

3. Open the machine.config file for editing and location the DbProviderfactories tag. 

4. Add the lines below and do not delete any existing data. 
  <system.data> 

    <DbProviderFactories> 

      <add name="EF Oracle Data Provider" invariant="EFOracleProvider" 
description="EF Provider for Oracle testing" 
type="EFOracleProvider.EFOracleProviderFactory, EFOracleProvider, 
Version=1.0.0.0, Culture=neutral, PublicKeyToken=def642f226e0e59b"/> 

    </DbProviderFactories> 

  </system.data> 

Configure the Perceptive Intelligent Capture database (post install) 
After the installation of Perceptive Intelligent Capture with Database there are additional configuration 
steps that are required.  

1. Check the project file names. The project file name will be used to display the available project lists in 
Web Verifier. 

2. Review the list of users in the projects. 

• All usernames and passwords must be consistent throughout all project files. 

• Each user must have their own username and password – user IDs cannot be shared. 

3. Export the users from the project file into the Perceptive Intelligent Capture database. This will now 
make users available to access projects via the Web Verifier. 

4. Log into the User table (known in ORACLE as USER_) and for each user, add a Forename and 
Surname into the Perceptive Intelligent Capture database. 

5. Create a Runtime Server instance for the project, or import existing Runtime Server settings, and 
configure again the Perceptive Intelligent Capture database (creating a job and linking to the 
Perceptive Intelligent Capture database). 

You are now ready to use Perceptive Intelligent Capture with Perceptive Intelligent Capture database. 
For information on how to configure a project for a Perceptive Intelligent Capture instance with Perceptive 
Intelligent Capture database, or to migrate file system batches to the Perceptive Intelligent Capture 
database, refer to the Perceptive Intelligent Capture Runtime Server User’s Guide. 
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Cedar Workflow History Wrapper Component 
Perceptive Intelligent Capture5.6 introduces an intermediate wrapper component for Workflow History 
related operations to achieve better compatibility of Visual Studio (VS) 6. 

The component Cedar Workflow History Wrapper (CdrWH.dll) has to be installed and registered in 
\Perceptive\Components\Cedar directory. 

The component is a COM component created with VS 2008 (V9) C++ and wraps the currently available 
base component for Workflow History operations, which is the Cedar Database Access component 
(CdrDB.dll). 

To access the Workflow History functionality, the CdrWH.dll should be used instead of the CdrDB.dll.  

Install Perceptive Intelligent Capture in a Workgroup Configuration 
A Windows Workgroup, also referred to as Peer-to-Peer networking, is a network implementation of 
Windows-based operating systems (clients and servers) in which there is no central security authority 
(domain controller) responsible for user authentication or a central repository (such as Active Directory) 
for locating network resources.  

In such a network, each machine is responsible for securing its resources, and users needing access to a 
resource located on a machine must have an account defined on that machine. Windows Workgroup 
networking should only be used when you want to set up communication between a limited number of 
computers (less than 10) and the machines are not members of a Windows domain. 

For an implementation of Perceptive Intelligent Capture in corporate network environments that are 
standardized on network operating systems (servers) other than Windows – Novell Netware – a Windows 
Workgroup setup may be the only choice. To install Perceptive Intelligent Capture in Windows 
Workgroup, log on as an administrator and complete the following steps. 

1. Create a user with the same name on each Perceptive Intelligent Capture machine. Perceptive 
recommends Perceptive Intelligent Capture RTSsvc as the user name. (This does not apply to 
machines that will be used only as a Designer or Verifier workstation.) 

2. Add the above user to the local Administrators group on each Perceptive Intelligent Capture server. 

3. Install Perceptive Intelligent Capture on each machine by following the steps in section Software 
Installation. 

4. Configure and start the Runtime Service Manager by performing the steps in section Configure the 
Runtime Service Manager on each machine, with the following exception: Wherever a domain user 
is requested, add the user created in step 1 above. 

5. Configure the RTS Remote Administration MMC snap-in by performing the steps in section 
Configure the RTS RemoteAdmin MMC Snap-in on each machine. 

6. Configure project settings on each machine and test the instance created in Step 5 above. You 
should (at a minimum) test the OCR, Classification, and Extraction workflow steps. For more 
information on how to configure project settings for a Perceptive Intelligent Capture RTS instance, 
see the Perceptive Intelligent Capture Runtime Server User’s Guide. 

7. Once you have successfully tested each machine, test remote communication by adding a remote 
machine to the local MMC snap-in of one your servers. You can accomplish this by performing a 
subset of the steps (Steps 4 through 7) in section Configure the RTS RemoteAdmin MMC Snap-in. 

8. You should be able to administer the RTS instances (start, stop, change batch states, etc.) of the 
remote machine from the MMC snap-in of the local machine on which it was added. 
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Install Perceptive Intelligent Capture in Standalone Mode 
Perceptive Intelligent Capture can be deployed in a standalone mode. However, this implementation 
method is intended for test and demonstration purposes only. It should NOT be used in a production 
environment. Deployment of  
Perceptive Intelligent Capture in Standalone mode for production purposes would be deemed 
unsupported by Perceptive. 

In this setup, all Perceptive Intelligent Capture components (applications, RTS, Remote Admin MMC 
snap-in, etc.) are installed and intended to be used on a single machine. Additionally, the integrated 
machine is not part of a Windows domain or is not intended to communicate with Perceptive Intelligent 
Capture RTS instances running on other machine(s) in a network environment. 

Using this setup, almost all of the configuration constraints (Windows domain, Users and Groups, etc.) 
can be ignored. 

To install Perceptive Intelligent Capture in a standalone mode, complete the following steps. 

1. Attach your supplied hardware key (serial or USB dongle) to the machine. 

2. Install Perceptive Intelligent Capture Version 5.6 by following the steps in section Install Perceptive 
Intelligent Capture in a Workgroup Configuration. 

3. Replace the demo license file, zCroDemo.lic, located in the …\Perceptive\Components\Cairo folder, 
with a valid license file corresponding to the serial number of your supplied hardware key. Perceptive 
Intelligent Capture license file names are usually in the format *_xxxxxxxx.lic: where * can be any 
number of alphanumeric characters and xxxxxxxx is an eight-digit number representing the serial 
number printed on the corresponding dongle. 

4. Configure the RTS Remote Administration MMC snap-in by following the steps in section Configure 
the RTS RemoteAdmin MMC Snap-in with one exception: In Step 6 of the procedure outlined, type 
LocalHost instead of the server name. 

5. Configure project settings and test the instance created in step 4 above. You should (at a minimum) 
test the OCR, Classification, and Extraction workflow steps. For more information on how to configure 
project settings for a Perceptive Intelligent Capture RTS instance, see the Perceptive Intelligent 
Capture Runtime Server User’s Guide. 
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Check the Installation 
The installation was successful if Perceptive Intelligent Capture runs without errors. 

To check for the correct installation of components, complete the following steps. 

1. Open the installation directory. 

2. Open \Components\Tools. 

3. Run SCBLibVersion.exe.  

4. From the menu, select View>Components General Info. This displays a list of installed components: 

5. Check the list for 

• Completeness of components 

• Homogeneity of build numbers 

• Installation paths 

6. All components Cro*.dll, Cdr*.dll and Bwe*.dll should have been registered automatically during the 
installation. If some of them seem to be missing, try to register them manually via the RegCro.bat, 
RegCdr.bat and BweReg.bat Windows batch files available in .\Components\Cairo, 
.\Components\Cedar and the corresponding .\Components\Bwe directories.  

If the automatic registration does not work, try to register manually using the program regsvr32.exe from 
the Windows system directory. 

If this does not help, create a copy of the components list using the command File>Save to file in the 
Perceptive Component Version Info dialog box. Submit an error report, the components list, and the log 
files located in the ...\ Perceptive\Perceptive Intelligent Capture\bin\Log folder to Perceptive Customer 
Support. 

Migrate Existing Project Files to Version 5.6 
After you remove the earlier version of Perceptive Intelligent Capture and install Version 5.6, project files 
designed in the earlier version must be converted to Version 5.6 formats before they can be used in the 
new version.  

The conversion process is fully automated and is done by Perceptive Intelligent Capture Designer. To 
convert project files created with earlier versions of Perceptive Intelligent Capture to Version 5.6, 
complete the following steps. 

1. Launch Perceptive Intelligent Capture Designer.  

2. On the Load Project dialog box, browse to the project file location and double-click the project file 
that you want to convert. Log in to the project using Administrator for User ID with the 
corresponding password.  

3. Click OK to launch the automatic project conversion process. The conversion takes from a few 
seconds to a few minutes, depending on the size of the project.  

4. Once the conversion is completed, click Learn (Light bulb) to relearn the project. 

5. Save the project. The project is ready for use in Perceptive Intelligent Capture Version 5.6. 

Important  You should always take a backup of the project and the Learnset. 

For information on how to configure a project for a Perceptive Intelligent Capture database, refer to the 
Perceptive Intelligent Capture Designer User’s Guide. 
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Remove Perceptive Intelligent Capture Version 5.6 
Perceptive Intelligent Capture can be uninstalled by using the Windows Control Panel’s Add/ Remove 
functionality. It is important to stop all running services using the Task Manager before uninstalling the 
application. To remove previous versions of Perceptive Intelligent Capture, complete the following steps. 

1. Click Start > Settings > Control Panel. 

2. Launch the Add/Remove Program wizard. 

3. On the Currently Installed Programs list, select Perceptive Intelligent Capture V5.6. 

4. Click Remove.  

5. Follow the on-screen instructions. 

6. After un-installation, reboot your computer.  

Repair a Perceptive Intelligent Capture Version 5.6 Installation 
The Perceptive Intelligent Capture installer may be used to repair a copy of Perceptive Intelligent Capture 
that has stopped working properly. The following factors could cause an installation to malfunction. 

• Accidental deletion of application files 

• Missing registry entries 

• Corrupted application files 

• Malicious attacks on a machine housing Perceptive Intelligent Capture 

To repair Perceptive Intelligent Capture, complete the following steps. 

1. Select Start > Settings > Control Panel. 

2. Select Add/Remove Program.  

3. In the Currently Installed Programs list on the Add/Remove Programs dialog box, select 
Perceptive Intelligent Capture v5.6. 

4. Click Change.  

5. Read and confirm the end-user license agreement. You need to agree to the end-user license to 
proceed with the repair step. 

6. On the Setup dialog box, select Repair and then click Next. This process reinstalls all program 
components that were installed by the previous setup. 

7. Click Finish when setup is completed. 

Add or Remove Version 5.6 Components 
Perceptive Intelligent Capture is a product suite consisting of the following applications. 

• Perceptive Intelligent Capture Runtime Server 

• Perceptive Intelligent Capture Designer 

• Perceptive Intelligent Capture Verifier 

• Perceptive Intelligent Capture Web Verifier 

The Perceptive Intelligent Capture deployment utility, Setup.exe, uses a modular approach that enables 
you to add or remove applications from a machine. 
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To modify an existing Perceptive Intelligent Capture installation, complete the following steps. 

1. Select Start > Settings > Control Panel. 

2. Select Add/Remove Program.  

3. In the Currently Installed Programs list, select Perceptive Intelligent Capture V 5.6. 

4. Click Change. 

5. Read and confirm the end-user license agreement. You need to agree to the end-user license to 
proceed with the repair step. 

6. On the Setup dialog box, select Modify and click Next.  

7. In the Select Components dialog box, select or clear the desired components. 

8. Click Next. Setup adds (if checked) or removes (if unchecked) the components. 

9. Click Finish when setup completes. 

Install Perceptive Intelligent Capture Service Packs and Service 
Updates 
Interim updates, minor enhancements, and defect corrections for Perceptive Intelligent Capture are 
typically released as a service pack. Service Packs for Perceptive Intelligent Capture are self-extracting 
executables. Perceptive distributes them in a number of ways, including e-mail and product CDs. 

A Release Notes document detailing the product issues addressed and deployment instructions specific 
to that service pack accompanies each Service Pack release. 

Current patch level 
To check for the current version of the combined patch you are using, complete the following steps. 

1. Check the file version for the Brainware.Verifier.WebClient.dll in the \Perceptive Intelligent 
Capture\bin directory. 

2. Check the highest file version of the Cdr*.dll in the \Components\Cedar and “Dst*.dll/exe file in the 
\Perceptive Intelligent Capture\bin. 

Password Encryption for Database Connection Strings in Core 
Config Files 
The application architecture of Perceptive Intelligent Capture makes it very important to be able to hide 
sensitive security information, such as DB access password, stored in Perceptive Intelligent Capture or 
custom project configuration files. 

Password encryption is optional and former configuration files with unencrypted passwords will still work 
with no issues. 

Note Maximum number of characters allowed to encrypt is 30. Passwords longer than 30 characters are 
not encrypted. 
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To encrypt the database connection password for the core Perceptive Intelligent Capture CONFIG files, 
complete the following steps. 

1. Open one of the Perceptive Intelligent Capture config files you use, for example 
.\Application\bin\DstDsr.exe.config in a text editor. 

2. Locate the connection string and the password part of the string as shown in the following example. 
<connectionStrings> 

    <add name="Entities" 
connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entities.ssd
l|res://*/Entity.Entities.msl;provider=System.Data.SqlClient;provider connection 
string=&quot;Data Source=MYSQLSRV;Initial Catalog=DatabaseName;Integrated 
Security=false;User ID=alexey; 
Password=MyPassword;MultipleActiveResultSets=True&quot;" 
providerName="System.Data.EntityClient" /> 

  </connectionStrings> 

3. Modify the password, replacing it with any amount of star signs, as shown in the following example. 
<connectionStrings> 

    <add name="Entities" 
connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity.Entities.ssd
l|res://*/Entity.Entities.msl;provider=System.Data.SqlClient;provider connection 
string=&quot;Data Source=MYSQLSRV;Initial Catalog=DatabaseName;Integrated 
Security=false;User ID=alexey; 
Password=********;MultipleActiveResultSets=True&quot;" 
providerName="System.Data.EntityClient" /> 

  </connectionStrings> 

Note The number of * is not important.  

4. Run the .Perceptive\Perceptive Intelligent Capture\bin\DstCrypt.exe tool using the following 
arguments. 

• DstCrypt.exe /text MyPassword >> my_encrypted_password.txt 

• Optional. You can add the line above to a new BAT file created in the Perceptive\Perceptive 
Intelligent Capture\bin\ directory and double-click it. This should produce a new file with the name 
my_encrypted_password.txt in the same directory where the executable is located. 

5. Open the resulting text file, which will contain text similar to the following example. Copy the 
information in red that represents the encrypted poassword. 
Text MyPassword encoded to 
Y652CeXVdMtdNtbnBD2itCEmfFFyHf9IGsN2psi6svy/MsKp8nKUgv2P7M37uu5rNo3V7wkH5795A5z6WG
ox/KEm60l6AG9flX+B5miOQg7iOgJCBqoHrsAbICHzm2EJbCkaMp1oUcvtP+8hpeJVMlBpD+QkfLlithUX
INhWaCM= 

6. Locate the appSettings section of your DstDsr.exe.config file and add the new EncrPwd key to this 
section, assigning the red encrypted sequence above to the value of the key as shown in the 
following example. 
  <appSettings> 

      <add key="EncrPwd" 
value=”Y652CeXVdMtdNtbnBD2itCEmfFFyHf9IGsN2psi6svy/MsKp8nKUgv2P7M37uu5rNo3V7wkH5795
A5z6WGox/KEm60l6AG9flX+B5miOQg7iOgJCBqoHrsAbICHzm2EJbCkaMp1oUcvtP+8hpeJVMlBpD+QkfLl
ithUXINhWaCM="/> 

  </appSettings> 

 



 

Percep t i ve  In te l l i gen t  Cap tu re  Ins ta l l a t ion  and  Se tup  Gu ide  

Page 39 of 2 

7. Save your DstDsr.exe.config file. 

8. When required, apply the previous steps to the other core configuration files that represent different 
applications. These applications are listed below. 

• For Runtime Server application: .\Application\bin\DstHost.exe.config 

• For Learnset Manager tool: .\Application\bin\DstSlm.exe.config 

• For Designer application: .\Application\bin\DstDsr.exe.config 

• For Thick Verifier application: .\Application\bin\DstVer.exe.config 

• For Supervised Learning nomination feature of Web Verifier application: 
.\Application\bin\Brainware.System.Project.exe.config 

• For Web Verifier application: .\Application Web Server\web.config 

Note Corrupted or incorrect encryption key or an incorrect password in the web.config file entails a 
Login failed error message when trying to open the Web Verifier application. 

 

INI File Encryption 
Perceptive Intelligent Capture allows the user to encrypt a password within the open text INI file. For 
example, for database connections (Reporting, PO Lookup), SAP connections (Export), etc. RSA 
encryption is used which contains a public key and a private key. 

Public Key: provides customer or PS integrated, for user who wants to encrypt text in INI file. It is 
distributed to PS teams and customer service for generating an encrypted passwords. 

Example: 
<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHElo750cpTuEzLPk6iz6bHAodPVgLFaOEK+XMMS2G5z+6961v
uQsDGUt+O1Ag1PiTXCa6rrAaeCaaDO4HI8Mmpw0OkUZEfCZpTTYCYQPfZlgokwomF6VDSB9dlUS430IT0gctQY1b5iM4MqT0=
</Modulus><Exponent>AQAB</Exponent></RSAKeyValue> 

Private Key: held by project owner/ developer only. 

Example: 
<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHElo750cpTuEzLPk6iz6bHAodPVgLFaOEK+XMMS2G5z+6961v
uQsDGUt+O1Ag1PiTXCa6rrAaeCaaDO4HI8Mmpw0OkUZEfCZpTTYCYQPfZlgokwomF6VDSB9dlUS430IT0gctQY1b5iM4MqT0=
</Modulus><Exponent>AQAB</Exponent><P>8SRHEvT5Bn2paRHSDR9yCQb7WGYE9PbeHzuqwH6iWa0LNYJrSrhhUeCEpwl
PLQWQq10KmMZgG0+Br4nuBMmMHQ==</P><Q>yD7l9fjB/MJWYaV3LcEzY286Q+Xvo74i6THvHkKqB1NKYGcN9xF9d8XbiUQNg
BZ/4F02T6mFeYDO32KFVRXHoQ==</Q><DP>nRDTFn7nwRmSgfRwi8minkyk5DQ3IFO35EIZ+x3Ao4Z52ZWkStwDz6/c12vR3X
JVg7irkU0NBlzoDK1bklSw5Q==</DP><DQ>B3xieGmORva05/2ZkPpSA3ubAALOjJ6FC5a0S7tOQ+vXMfdoTD45JIsfA+ipYI
p2yVpyt1OtC7fHBA7Y0S95QQ==</DQ><InverseQ>4S1xqlXK9f1rawGCbFWOVp6lz1fCoQ8RfyDE87/G/pUilHRJV2acBAcn
gY3c/MRMKrXQb8lx99k7dENUYc8ywQ==</InverseQ><D>KAL6cwkCQKgbuvKFRNSLZmFOqV2JpB5kI/p1U+0GWAs6Qi4wnPq
y+53O3naOa2faPctXLSKJqvlvSz21VDMUCsyphvOSxBtc1cZHJp4ueQPA7u+qrIJaDY1RhlAVoqNfCJFX6+McVJ+I/X+mZOCt
dUaCuAoNn014UYOaMujYDQE 

=</D></RSAKeyValue> 

Below is the new connection string parameter: 
SQL_VL_01_ConnectionString=Provider=SQLOLEDB.1;Persist Security Info=True;User ID=sa;Initial 
Catalog=MyData;Data Source=10.4.0.19 

SQL_VL_01_ConnectionPassword=MyEncryptedPassword 
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INI File Encryption for Project Developer 
The idea of coding is to locate the code that calls Database Connection from the INI file, so that you can 
read the new line in the INI file with an encrypted line text. The password then can be decrypted by using 
a Private Key. At last, you append the password to the end of the Connection String in the INI file. 

As a project developer, you can select the CdrCrypt ScriptModule in the Reference section of Project File 
Script Page. 

 
Figure 1: Script Module References 

Note Additional security can be provided by Encrypting Script Page. 

Example script of the encrypted password: 
  Dim theCedarCryptographyHelper As New CdrCrypt.RSACodecInt 

  Dim strEncryptedPassword As String 

  Dim strOpenPassword As String 

  Dim strPrivateKey As String 

  strPrivateKey = 
"<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHElo750cpTuEzLPk6iz6bHAodPVgLFaOEK+XM
MS2G5z+6961vuQsDGUt+O1Ag1PiTXCa6rrAaeCaaDO4HI8Mmpw0OkUZEfCZpTTYCYQPfZlgokwomF6VDSB9dlU
S430IT0gctQY1b5iM4MqT0=</Modulus><Exponent>AQAB</Exponent><P>8SRHEvT5Bn2paRHSDR9yCQb7W
GYE9PbeHzuqwH6iWa0LNYJrSrhhUeCEpwlPLQWQq10KmMZgG0+Br4nuBMmMHQ==</P><Q>yD7l9fjB/MJWYaV3
LcEzY286Q+Xvo74i6THvHkKqB1NKYGcN9xF9d8XbiUQNgBZ/4F02T6mFeYDO32KFVRXHoQ==</Q><DP>nRDTFn
7nwRmSgfRwi8minkyk5DQ3IFO35EIZ+x3Ao4Z52ZWkStwDz6/c12vR3XJVg7irkU0NBlzoDK1bklSw5Q==</DP
><DQ>B3xieGmORva05/2ZkPpSA3ubAALOjJ6FC5a0S7tOQ+vXMfdoTD45JIsfA+ipYIp2yVpyt1OtC7fHBA7Y0
S95QQ==</DQ><InverseQ>4S1xqlXK9f1rawGCbFWOVp6lz1fCoQ8RfyDE87/G/pUilHRJV2acBAcngY3c/MRM
KrXQb8lx99k7dENUYc8ywQ==</InverseQ><D>KAL6cwkCQKgbuvKFRNSLZmFOqV2JpB5kI/p1U+0GWAs6Qi4w
nPqy+53O3naOa2faPctXLSKJqvlvSz21VDMUCsyphvOSxBtc1cZHJp4ueQPA7u+qrIJaDY1RhlAVoqNfCJFX6+
McVJ+I/X+mZOCtdUaCuAoNn014UYOaMujYDQE=</D></RSAKeyValue>" 

  strEncryptedPassword = DicVal("01" & "ConnectionPassword", "SQL") 

  If Len(strEncryptedPassword) > 0 Then 

    strOpenPassword = theCedarCryptographyHelper.Decode(strEncryptedPassword, 
strPrivateKey) 

  End If 

  If Len(strOpenPassword) > 0 Then 

    strConnection = strConnection + ";Password=" + strOpenPassword 

  End If 
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INI File Encryption for Integrator 
As an integrator, you simply need to add the encrypted customer password, and encrypt the password 
similarly to Config files. 

Run the following command in the Perceptive\Perceptive Intelligent Capture\bin folder: 
DstCrypt.exe /text “MyPassword" /key 
"<RSAKeyValue><Modulus>vJ+W7SuXuvOrWVoy4tPrbfLCuoHElo750cpTuEzLPk6iz6bHAodPVgLFaOEK+XM
MS2G5z+6961vuQsDGUt+O1Ag1PiTXCa6rrAaeCaaDO4HI8Mmpw0OkUZEfCZpTTYCYQPfZlgokwomF6VDSB9dlU
S430IT0gctQY1b5iM4MqT0=</Modulus><Exponent>AQAB</Exponent></RSAKeyValue>" >> 
my_encrypted_custom_password.txt 

The my_encrypted_custom_password.txt will now contain the encrypted text string for the password. 

And then, add the encrypted password to the ConnectionPassword INI tag. 
SQL_VL_01_ConnectionPassword=puejB5SQNCFGgwe6MRoWc1G1y7qX8xSAhgUZjhN6JolhYdKIxla7vLMU4
bYmG9V3Ayxualp/ObgXRqnSAmGsGF1FPZXktRmf58SXbnCDXmYrYgp8eS3IaqiLUPrhTiRCvfr8ZsMtK+3usma
hfxpESUOQ7MZf36suWV4V3sBf9Xw= 

Silent Installations 
A Silent Install mode is provided for situations where the same configuration of Perceptive Intelligent 
Capture is to be installed on several machines, for example, Verifier workstations. The use of a 
configuration file removes the necessity to go through the installation dialog on each machine. 

Silent Install.ini 
The configuration settings for the silent installation are read from the “Silent Install.ini” file in the 
Perceptive Intelligent Capture installation directory. The directory contains an example file which must be 
edited before performing a silent installation. 

The file contains seven sections – General, Applications, OCR Engines, Additional, AutoServiceUpdate, 
Database Configuration, and DB Credentials. 

It’s allowed to delete single entries or complete sections. 

However, it's not allowed to use options without the section name. If any information is deleted from the 
"Silent Install.ini" file, the Setup uses the DEFAULT values as described.  

Name Description 

[General] Determines how and where Perceptive Intelligent Capture is to be installed. 

Path = Indicates where the application should be installed. The pathname should 
not have a final backslash. 

Example: Path = C:\Program Files\your company name.  

EULA = The end-user agreement needs to be accepted on each machine where the 
software is installed. If this section is not modified in the silent install.ini file, 
the silent installation would be canceled. 

0: Accepted 

1: Not accepted 
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Name Description 

MoveComponentsIfRequired 
= 

If an older version of the application is installed, this indicates whether to use 
the existing component folder or whether to move the old components into 
the new directory prior to installation. 

0: Use existing component folder. 

1: Move components to the new path. 

CreateDeskTopIcons = 0: Don’t create desktop shortcuts. 

1: Create desktop shortcuts. 

InstallWibuKey = 0: Skip Wibukey driver installation. 

1: Install Wibukey drivers. 

StopIfDotNetIsNotFound = # 0: If .Net Framework 3.5 SP1 is not found on the system the installation 
proceeds.  

The Features (WebVerifier, Database Connection...) will not be installed. 

1 (DEFAULT): If .Net Framework 3.5 SP1 is not found on the system the 
installation will be aborted. 

[Applications] Defines which applications are to be installed.  

Note that it is permissible to skip all applications if, for example, only the 
extraction components are to be installed. 

Designer = 0: Skip installation of the Designer application. 

1: Install the Designer application. 

Verifier = 0: Skip installation of the Verifier application. 

1: Install the Verifier application. 

Runtime Service = 0: Skip installation of the Runtime Server application. 

1: Install the Runtime Server application. 

Web Verifier=  0: To skip installation of WebVerifier application (Thin Client) 

1 (DEFAULT): Install WebVerifier application (Refer to option 
StopIfDotNetIsNotFound) 

[OCR Engines] Defines which OCR engines are to be installed. It is permissible to skip all 
the engines. 

FineReader10 = 0: Skip installation of ABBYY FineReader 10. 

1: Install ABBYY FineReader 10. 

FineReader11 = 0: Skip installation of ABBYY FineReader 11. 

1: Install ABBYY FineReader 11. 
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Name Description 

Kadmos5 = 0: Skip installation of Kadmos 5 engine. 

1: Install Kadmos 5 engine. 

Recognita = 0: Skip installation of Recognita engine. 

1: Install Recognita engine. 

QualitySoft 0: Skip installation of QualitySoft engine. 

1: Install QualitySoft engine. 

Cleqs = 0: Skip installation of Cleqs engine. 

1: Install Cleqs engine. 

[Additional] Additional files to install. 

Demo Files = 0: Skip installation of the demo project files. 

1: Install demo project files. 

[AutoServiceUpdate] Defines the installation of automatic ServiceUpdate (will be skipped if 
ForDesigner and ForVerifier are skipped) 

ForDesigner = 0 (DEFAULT): Skip definition of ServiceUpdate for Designer Application. 

1: Defines Shortcut for Designer start with automatic ServiceUpdate 

ForVerifier = # 0 (DEFAULT): Skip definition of ServiceUpdate for Verifier Application. 

1: Defines Shortcut for Verifier start with automatic ServiceUpdate. 

NetworkUpdateFolder = "*" Path where automatic ServiceUpdate looks for Updates.  

(DEFAULT empty string) 

[Database Configuration] Configures Existing DatabaseServer (Refer to option 
StopIfDotNetIsNotFound). 

DBServerType = # 1: SQL Server database will be configured. 

2: Oracle Server database will be configured. 

3 (DEFAULT): No database will be configured. 

If there is any wrong information for the following options DBServerType will be set to 3 

UseDBConfIniFile = "*" Text file name that contains Database Connection String.  

If this option is empty, credentials will be taken from [DB Credentials] section. 

If there is neither a config file nor a [DB Credentials] section, DBServerType 
will be set to 3 (no database) internally.  

(DEFAULT empty string). 
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Name Description 

[DB Credentials] This section can be used instead of a config file (See Option 
UseDBConfIniFile). 

(DEFAULT database cofiguration will be skipped, if option UseDBConfIniFile 
is not set). 

Only for SQL Server Usage (See Option DBServerType and UseDBConfIniFile) 

SQLServerWindowsAuthent = 0 (DEFAULT): No Windows Authentication will be used for DBA. 

1: Windows Authentification will be used for DBA. 

SQSqlerverAdminUser = "*" DBA account name (Refer tooption SQLServerWindowsAuthent) 

(DEFAULT empty string). 

SQLServerAdminPassword = 
"*" 

DBA account password (Refer tooption SQLServerWindowsAuthent) 

(DEFAULT empty string). 

For both Database Server Types (See Option DBServerType and UseDBConfIniFile) 

DBUserWindowsAuthent = # 0 (DEFAULT): No Windows Authentication will be used for DB user. 

1: Windows Authentification will be used for DB user. 

DBUserName = "*" DB user account name (Refer tooption DBUserWindowsAuthent) 

(DEFAULT empty string). 

DBUserPassword = "*" DB user account password (Refer tooption DBUserWindowsAuthent) 

(DEFAULT empty string). 

DatabaseServerPath = "*" Name of the database. Ususal it is build like 
<MachineName>\<InstanceName> 

 (DEFAULT empty string). 

An example "Silent Install.ini" INI-file is available in the root setup directory. 

  

 



 

Percep t i ve  In te l l i gen t  Cap tu re  Ins ta l l a t ion  and  Se tup  Gu ide  

Page 45 of 2 

Prepare Internet Information Server (post install) 
One of the preconditions for working with Perceptive Intelligent Capture Web Verifier is the installation of 
the Internet Information Server. Windows 2003 Server works with IIS 6.0, Windows 2008 Server with IIS 
7.0. 

Perform the installation of the appropriate IIS application version. Use the following links for more 
information. 

• For Windows 2003 Server and IIS 6.0 

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-
b6c7-5f370d7f26cd.mspx?mfr=true 

• For Windows Server 2008 or Windows Server 2008 R2 and IIS 7.0/IIS 7.5 

http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/ 

Configure IIS 6.0 
The Internet Information Server is used for executing the Perceptive Intelligent Capture Web-Verifier. The 
IIS configuration is presented below. 

1. Run IIS manager (Start > Control Panel > Administrative tools – Internet Information Services). 

2. Extend Web Sites. 

3. Right-click the Default Web Site node, then choose New > Virtual Directory. 

 
Figure 2: IIS 6.0 manager 

 

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
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4. In the dialog box, click Next. 

 
Figure 3: Virtual Directory Creation Wizard 

5. Type the Alias you want to use to gain access to this Web virtual directory. Click Next. 

 
Figure 4: Alias for the Web virtual directory 

6. Type or browse to the physical directory in which the virtual directory resides, and click Next. 
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7. Set the permissions as shown in the screenshot below. Click Next. 

 
Figure 5: Virtual Directory Access Permissions 

8. Click Finish. 

9. Right-click the Web Verifier node then select Properties. 

10. In the dialog box, click the ASP.NET tab. 

11. Check the ASP.net version. If it is not a v.2.0 – set it to v.2.0. 

 
Figure 6: Setting the ASP.net version number 
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12. Select the Documents tab. Remove all default content pages, and add Login.aspx to the list. 

 
Figure 7: Documents tab – setting Login.aspx as default content page 

13. Click OK.  

The Perceptive Intelligent Capture Web Verifier application will be accessible by the address 
http://localhost/WebVerifier/login.aspx. 

Configure Web Verifier in IIS 6 
If you are using a Brainware-labeled version of the product, you do not have to complete the following 
task. For the Perceptive-labeled version, to configure the Web Verifier for in IIS7 Manager, complete the 
following steps. 

1. To run the IIS manager, click Start > Settings > Control Panel > Administrative tools – Internet 
Information Services. 

2. In IIS Manager, expand the local computer, and then expand the Web Sites node. 

3. To create the WL virtual directory, right-click the site or folder in which you want to create the virtual 
directory, then choose New > Virtual Directory. 

4. In the Virtual Directory Creation Wizard, click Next. 

 

http://localhost/WebVerifier/login.aspx
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5. In the Alias field, type WL as the name for the virtual directory. The physical path should point to the 
Cedar/WL folder. 

 

Configure IIS 7.0 
1. Run Server Manager (Start > Administrative tools > Server Manager). 

2. Extend the Roles directory. 

3. Click Add Roles. 

4. Select Web Server (IIS). You are prompted to install other required features.  

5. Click Add Required Features. 

 
Figure 8: Selecting Server Roles 

6. To select the Server Roles, complete the following substeps. 

1. Click Next. 

2. Continue by clicking Next. 

3. Select the Role Services as follows: 
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Figure 9: Roles selection example 

7. To confirm your selections, click Next. 

8. Click Install to install the selected roles, role services, and features. 

9. Check the Result overview and finish by clicking on Close. 

10. Now run IIS manager (Start > Administrative tools > Internet Information Services (IIS) 
Manager). 

 
Figure 10: IIS Manager 

11. Right-click Default Web Site. 

12. Select the Add Application menu item. 
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13. In the dialog box, enter the Alias you want to use to gain access to this Web virtual directory, usually 
WebVerifier. Set the Physical path to the directory with the installed Perceptive Intelligent Capture 
Web Server and then click OK. 

14. Double-click the Default Document icon for the WebVerifier application.  

 
Figure 11: Setting the Default Document II 

15. Click Add and add Login.aspx to the list. 

The Perceptive Intelligent Capture Web Verifier application is accessible through the 
http://localhost/WebVerifier/login.aspx address. 

Configure Web Verifier in IIS 7 
If you are using a Brainware-labeled version of the product, you do not have to complete the following 
task. For the Perceptive-labeled version, to configure the Web Verifier for in IIS7 Manager, complete the 
following steps. 

1. To run the IIS manager, click Start > Settings > Control Panel > Administrative tools – Internet 
Information Services. 

2. Locate the Web Verifier application under the Default Web Site node. 

3. To create the WL virtual directory, right-click on Web Verifier node, then choose New > Create 
Virtual Directory. 

4. In the Alias field, type WL as the name for the virtual directory.The physical path should point to the 
Cedar/WL folder. 

 

 

http://localhost/WebVerifier/login.aspx
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Windows 2008 64bit R2 
To configure IIS 7.5 for your operating system, complete the following steps.  

1. Create an application pool or change defaultAppPool with the following advanced properties.  

• Enable 32-bit applications = True 

• Managed pipeline mode = Integrated 

• Identity is set to NetworkService 

• Load User Profile = True 

2. Assign the Web Verifier application to this application pool so that the application can run under 32-bit 
mode. 

IIS 6.0 Metabase Configuration - MetaBase.xml 
To configure the IIS 6.0 metabase configuration, complete the following steps. 

1. Open Windows Explorer and go to C:\Windows\System32\inetsrv. 

2. Find the MetaBase.xml file and make a backup copy. 

3. Open the MetaBase.xml file in a text editor. Locate the <IIsCompressionScheme/> section. Be 
careful, there are two sections here: one for deflate and one for gzip. Select the section for gzip. 
(Refer to FIGURE 12) The Location attribute of this element has the following value: 
Location ="/LM/W3SVC/Filters/Compression/gzip".  

4. Locate the HcScriptFileExtensions section. As the default, it should contain: ASP, DLL, and EXE files. 
This is where you add any extensions you want compressed for dynamic files. For instance, you can 
add the extension ASPX.  

NoteUse a list format for the file extensions as in the sample below using a new line for each 
extension and indenting them using tabs.  

For Web-Verifier, this section should resemble the following example.  

 
Figure 12: MetaBase.xml 
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5. To save this document, open IIS, right-click the top node, Internet Information Services, and select 
Enable Direct Metabase Edit. 

6. To exit IIS and restart, right-click the Internet Information Services node, and then click All Tasks, 
Restart IIS. 

Run Multiple Web Verifier and RTS instances 
Description 

When running more than approx. 12 concurrent Web Verifier user sessions or more than approx. 14 
Runtime Service instances, the system may start experiencing lack of Windows desktop heap resources 
and the extra user sessions / RTS instances can be failing with different internal memory allocation errors.  

Cause 

The default Windows OS setting of desktop heap size for the non-interactive Windows station often 
appears to be too low to host multiple simultaneously running Web Verifier or Runtime Service instances 
with extensive script engine utilization. 
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Recommended Configuration Changes 

1. Open Windows Registry Editor. 

2. Browse to the key [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\SubSystems\Windows]. 

3. Check or modify the third argument of the SharedSection parameter:  

SharedSection=1024,3072,512 

512 (KB) is exactly the default value that causes the issue as described in the "Problem Description" 
section above.  

Note For some OS versions, this default setting can be different. The table below gives the 
recommended values for this setting: 

# of RTS and/or WVC instances DH Size in KB 

1 – 10 512 

11 – 24 1024 

25 – 36 1536 

37 – 48 2048 

49 – 60 2560 

61 – 72 3072 

Legend 
DH Size: Desktop heap size for non-interactive window station  

# of RTS and/or WVC: Cumulative number of simultaneously running Runtime Service instances 
PLUS number of concurrent Web Verifier users running on the same physical server. 

4. After modifying this parameter reboot the server. 
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Configure Application 
Configuring Application 
There are some main configuration parameters to be accounted for. See Appendix A for more 
information. 

Configure Perceptive Intelligent Capture Database connection string  
To configure the connection string, complete the following steps.  

1. Open the application configuration file (Perceptive Intelligent Capture Web Server\web.config) 

2. Locate the following string. 
<connectionStrings> 

<add name="Entities" 
connectionString="metadata=res://*/Entity.Entites.csdl|res://*/Entity.Entites.ssdl|
res://*/Entity.Entites.msl;provider=System.Data.SqlClient;provider connection 
string=&quot;Data Source=NEO\SQLSERVER2005;Initial 
Catalog=Perceptive_verifier_work;Integrated Security=false;User ID=developer; 
Password=123456;MultipleActiveResultSets=True&quot;" 
providerName="System.Data.EntityClient" /> 

3. Modify the connection string in accordance with your database settings. 

4. Replace the connection string within the Brainware.System.Project.exe config file by the one 
configured within the web.config file.  

Note These two connection string entries must be identical to assure the availability of all Web Verifier 
functionalities associated with the Knowledge base.  

Set path to license file 
To set the path to the license file, complete the following steps.  

1. Open the application configuration file (Perceptive\Perceptive Intelligent Capture Web 
Server\web.config) 

2. Find the following string. 
<project.controller> 

<project licensePath="{app_root}\License\Runtime.lic" ... 

</project.controller> 

3. Modify the licensePath value in accordance with the location of your license file. 
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Enable HTTP compression for IIS 6.0 and IIS 7.0 
To enhance your application performance and to save server costs, it is recommended you enable HTTP 
compression in the context of the Internet Information Services.  

Use the following links for detailed information. 

For IIS 6.0: 
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/d52ff289-94d3-4085-bc4e-
24eb4f312e0e.mspx?mfr=true 

For IIS 7.0: 

http://technet.microsoft.com/en-us/library/cc771003.aspx 

Server Security Configuration 

Register COM components 
After applying a patch, locate and run the 'Register Web Server.bat' as administrator. It is located in the 
Perceptive Intelligent Capture Web Server\bin\ folder. For registering this component, complete the 
following steps.  

1. Right-click the Register Web Server.bat file. 

2. Select Open from the context menu. 

Prepare the User Context 
It is necessary for the user of the user context in which the Web Verifier is running in IIS to have the 
proper rights to access the SQL Server database. By default, the Web Verifier runs under the NETWORK 
SERVICE user context, hence the same should be allowed to access the database. 

If you select Windows Authentication during the installation of Perceptive Intelligent Capture, you will 
need to add the domain username to the SQL Server DB additionally to the NT AUTHORITY\NETWORK 
SERVICE.  

To add NETWORK SERVICE to SQL server, complete the following steps.  

1. Open Microsoft SQL Server Management Studio. 

2. Expand the local computer name, select Security  Logins. 

3. Right-click Logins and select New Login. 

4. In the Login dialog box, under General, click Search. In the Select User or Group dialog box, enter 
NETWORK SERVICE and then click Check Names. Click OK. 

5. Select sysadmin (public is selected by default) for Server Roles. Click OK. 

The NT AUTHORITY \NETWORK SERVICE is added to SQL server. 
After adding Network Service to SQL server, make sure that the IIS is running under NT AUTHORITY 
\NETWORK SERVICE by opening the IIS Manager. 
To open IIS Manager from Start menu, complete the following steps.  

1. Click Start and select Control Panel. 

2. Select Administrative Tools and click Internet Information Services (IIS) Manager.  

3. In the Connections pane, expand the server node and click Application Pools. 

 

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/d52ff289-94d3-4085-bc4e-24eb4f312e0e.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/d52ff289-94d3-4085-bc4e-24eb4f312e0e.mspx?mfr=true
http://technet.microsoft.com/en-us/library/cc771003.aspx
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4. In the Application Pools pane, select the application pool which you want to specify an identity, and 
then click Advanced Settings in the Actions panel. 

5. For the identity property, the built-in account should be NetworkService. 

 
Figure 13: Identity. 

1. If it does not contain NetworkService, click Set to open the Application Pool Identity dialog box. 

2. Select the Built-in account option and select NetworkService account from the list. 

Set Permissions for Perceptive projects execution 
All Perceptive projects are located in a filesystem folder. The Web Verifier sources this path from the 
Perceptive Intelligent Capture Database. Perceptive projects are loaded by the 
“Brainware.System.Project.exe” process. This process cannot load the projects until it has the appropriate 
permissions for the projects folder. In this case, to grant permission to the “Network Service” Windows 
user for this folder, complete the following steps.  

1. Select the projects folder. 

2. Right-click the folder and select Properties. 

3. In the dialog box, click the Security tab.  

4. Add the Network service user to the list. 
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Encrypt sections with aspnet_regiis tool 
If you want to protect the data stored in the configuration file perform the following steps:  

Pre-configuring: 

• Find the Brainware.System.AppConfiguration.dll file in the Perceptive Intelligent Capture\bin\ 
directory. 

• Register this assembly in the GAC using the  

gacutil -I Brainware.System.AppConfiguration.dll command. 

Encryption of the web.config file: 

• Use the aspnet_regiis command-line tool. This tool is located at: 
C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\aspnet_regiis.exe 

• For encrypting a particular section of the configuration file, you can use the -pe option when executing 
the aspnet_regiis tool. 

For example, for encryption of the connectionStrings section use: 

aspnet_regiis -pe connectionStrings -app/MyApp 

Note The “-app” option is used to specify the application’s virtual path. 

Decryption of the web.config file: 

• For decryption of a configuration section, use the following command: aspnet_regiis -pd 
connectionStrings -app/MyApp 
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Client Security Configuration 
This section describes security configuration for the client side. 

• Open your Internet Browser. Select Tools > Internet Options, and then select the Security tab. 
Click Custom Level… 

 
Figure 14: Internet Browser – Security tab 

• Check for the configuration settings (See the screenshots below) 

• ActiveX controls and plug-ins: 

• Binary and script behaviors setting should be Enable. 

• Run ActiveX controls and plug-ins setting should be Enable. 
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Figure 15: Custom level configuration settings – ActiveX controls and plug-ins 

• Scripting 

• Active scripting setting should be Enable. 

• Allow status bar updates via script setting should be Enable. 

Note Only if allowing status bar updating via script is enabled, will the information on batches, 
documents, current filters and page number be displayed.  
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Figure 16: Custom level configuration settings – Scripting 

Configure Single Sign-On Authentication for Web Verifier 
Note Configuration of the SSO Service Provider is out of scope of this document. Refer to the provider’s 
product documentation. 

Web Verifier has been enhanced to support Single Sign-On (SSO) user authentication. The SSO 
implementation will intercept user’s login request and either gather the user credentials and authenticate 
the user, or accept the user as already authenticated. 

The SSO functionality is implemented as a generic solution to work with any SSO implementation and 
configuration that provides the user credential information via an HTTP header. 

  

 



 

Percep t i ve  In te l l i gen t  Cap tu re  Ins ta l l a t ion  and  Se tup  Gu ide  

Page 62 of 2 

Enable Single Sign-On Authentication 
To turn on external authentication, the following changes are required in the web.config file: 

1. Check the <verifier.webclient> section for the <httpHeaderBasedSso> parameter. 

2. Set the flag for the enabled setting to true: <httpHeaderBasedSso loginHeader="idUserName" 
enabled="true" sessionHeader="ShibSessionID" /> 

3. Set the loginHeader value to the HTTP header attribute name which is returned by the SSO service - 
for example, loginHeader="remoteuser". 

4. Set the sessionHeader parameter to the default session ID header used by the SSO provider. 

SSO Session vs. Web Verifier Client Session 
There are two different sessions when SSO is used – SSO session and WVC session. SSO session has 
generally longer life as it might be used for other applications and not only for WVC. 

WVC and SSO sessions are renewed with every server request (for example field validation, opening 
next batch), and are not renewed with client-side actions (for example zooming in page image or typing a 
value into form field without validating it). 

Note When SSO authentication mode is used, the WVC session timeout must be set to a smaller value 
than the SSO session timeout. Otherwise, if the SSO session times out while the WVC session is still 
active, the user will be re-directed to the SSO login page, and any changes made in Web Verifier will be 
lost. 

<sessionState timeout="20"/>  

Refer to the product documentation of your SSO provider for details how to configure the SSO session 
duration. 

Configure Windows Authentication for Web Verifier 
The Web Verifier application allows you to login with your Windows user account. In this case, the 
password that is shared with Windows will be used to login into Web Verifier.  

To use this option, you first need to configure the server. 

Note Only Windows Authentication access is possible after this option is configured. However, when 
logged in to Web Verifier through Windows Authentication, it is possible to use the re-login menu option to 
login for example as an administrator to perform certain administrative tasks.  

The prerequisites that apply to both IIS 6 and IIS 7 are listed below. 

• Before you start to configure IIS, make sure that the Web Verifier application is working properly 
using an existing project user account. 

• Back up the web.config file. 
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For IIS 7 
To configure Windows Authentication access to Web Verifier with IIS 7: 

1. Open Authentication settings in IIS group for the WebVerifier application. 

2. Enable Windows Authentication and disable all other authentication methods. 

3. Close all of the running browser sessions prior to access the Web Verifier application. 

4. Add the Windows user to the database. Refer to the Designer User Guide for information on how to 
do this. 

Note In IIS 7, Error Pages are configured automatically. 

For IIS 6 
To configure Windows Authentication to Web Verifier with IIS6, complete the following steps. 

1. Open the WVC application properties.  

2. Select the Directory Security tab. In the Authentication and access control section, click Edit. 

 

Figure 17: Entering the Authentication and access control area 
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3. In the Authentication methods dialog box, enable Integrated Windows Authentication and 
disable all other authentication methods 

 

Figure 18: Enabling/Disabling authentication methods 
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4. To enable the custom error page for Not Authorized status, which is required to configure IIS to 
redirect to <Web Verifier Installation Directory>/ErrorPages/401.htm when a  401.x error is 
received, complete the following substeps.  

1. Select WVC application properties.   

2. On the Custom Errors tab, select all of the 401;x error code properties and click Edit. 

3. In the Edit Custom Error Properties dialog box, select File for Message Type. 

4. Enter the path to the <Web Verifier Installation Directory>/ErrorPages/401.htm file. 

 

Figure 19: Custom Error properties for 401 errors 
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Figure 20: Editing Custom Error properties 
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5. To enable custom error page for Not Found status, which is required to configure IIS to redirect to 
<Web Verifier Installation Directory>/ErrorPages/404.htm when 404.x error is received, complete the 
following substeps. 

1. Select WVC application properties. 

2. On the Custom Errors tab, change all 404;x error code properties to point to the<Web Verifier 
Installation Directory>/ErrorPages/404.htm file. 

 

Figure 21: Custom Error properties for 404 errors 
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6. To prevent the Not Found page from being shown for invalid ASPX addresses (such as Batch.aspx – 
does not exist but would be a valid page name from IIS point of view), complete the following 
substeps to configure IIS. 

1. Go to properties of Default Web site. 

2. On the Home Directory tab, click the Configuration button. 

3. In the Network and Configuration dialog box, select the Mappings tab. 

4. Select the .aspx extension option from the list and click Edit. 

5. Select the Verify that file exists check box.  

 

Figure 22: Configuring the “Not Found” page to be shown 

7. After submitting, the Inheritance Overrides dialog box displays. Select the WebVerifier application 
to apply this setting. 

Note The Not found error page configuration is also used for standard authentication mode. 

8. The web.config file needs to be modified. Refer to the .Changes to Web.config File section.  

9. Close all of the running browser sessions prior to accessing the Web Verifier application. 

10. Add the Windows user to the database. Refer to the Designer User Guide for information on how to 
complete this task. 

Changes to Web.config File 
It is highly recommended to have two versions of the web.config file – one for standard authentication and 
one for Windows Authentication. This will simplify switching between modes. 

The following list shows required steps to convert standard web.config to a web.config with Windows 
Authentication enabled. 

The steps generally apply to both, IIS 6 and IIS 7. Exceptions are mentioned appropriately. 

1. Change <authentication> section (located in the <configuration><system.web>) to the following: 
 <authentication mode="Windows"> 
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2. Remove the following line: 
<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx" />  
This is a child of the <authentication> section, and is only needed for standard authentication. 

3. Change <authorization> section (located in the <configuration><system.web>) from ‘deny’ to ‘allow’: 
<authorization> 
    <allow users="?"/> 
</authorization> 

4. Add enableSessionState attribute to <pages> section (located in the <configuration><system.web>): 
<pages enableSessionState="true"> 

5. Remove all <location> sections (located in the <configuration> right before <appSettings>). Those 
sections look like the following: 
<location path="WL"> 
    <system.web> 
        <authorization> 
            <allow users="*" /> 
        </authorization> 
    </system.web> 
</location> 

6. This step only applies to IIS 6. 

For correct display of ‘Not Found’ error page add section <customErrors> after <authorization> 
section to be the following 
<customErrors mode="On" defaultRedirect="~/Error.aspx"> 
    <error statusCode ="404" redirect="~/ErrorPages/404.htm" /> 
</customErrors> 
The page referenced here is the same 404.htm that was configured in IIS settings. 
This “Not found” error page configuration is also used for standard authentication mode. 
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Revert Back to Standard Authentication 
To switch from Windows Authentication mode back to standard authentication mode, the following 
adjustments to IIS are required: 

IIS 7.x (Windows 7, Windows Server 2008, Windows Server 2008 R2) 
Refer to Step 2 of the For IIS 7 section. Disable Windows Authentication and enable both, Anonymous 
and Forms Authentication. 

IIS 6 (Windows Server 2003) 
Refer to Step 3 of section For IIS 6. Disable Windows Authentication and enable Anonymous 
Authentication. 

Changes to Web.config 
Get the back up file which was done at the beginning of the configuration process. 

Configuring SSL for Web Verifier 
For information on how to set up SSL on your Information Services machine,  refer to the respective third 
party product documentation. 

Configure Additional Languages 
Web Verifier supports an extended list of languages: 

Chinese Simplified, Chinese Traditional, Danish, Dutch, English, French, Finnish, German, Italian, 
Japanese, Korean, Norwegian, Polish, Portuguese, Romanian, Russian, Spanish, Swedish, Turkish. 

Note By default, the Chinese language selection points to Simplified Chinese. In case Traditional Chinese 
language has to be used, the content of the Bin\Resources\cmn folder can be copied into the "zho" folder, 
which contains the Simplified Chinese. Prior to overwriting the “zho” folder content, back it up. To display 
the correct language on the drop-down list of the language selection menu, a web.config change for the 
parameter LanguageDisplayName is needed. Refer to Appendix A for more information 

Virus Check 
The settings for the Virus Checker on the Web Server exclude the [Local Temp Folder]/CdrDbCache 
directory (Batch and the Common Learnset folders) from the locations which are checked for viruses. This 
is due to performance considerations. 

Enable New Columns for Batch View 
Four additional columns are available to hold additional information on batches:  

• Batch.ExternalGroupId - default display name: "User Group" 

data type: The Group ID which has been assigned to a batch is relating to security. Batches can be 
assigned to user group via a unique ID. For example, German invoices belong to Group 1 and 
English invoices belong to Group 2. When in a shared service center, you could hide all German 
invoice batches from English Verifiers. 

• Batch.ExternalBatchId - default display name: "Batch Group" 

data type: It allows the developer to uniquely identify the batch. For example, external system ID, 
storage box ID, etc. 
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• Batch.TransactionId - default display name: "Transaction" 

data type: It allows the developer to synchronize a newly created batch of documents with another 
external system. It can be used to identify originators of batch of documents. 

• Batch.TransactionType - default display name: "Transaction Type" 

data type: It allows the developer to synchronize a newly created batch of documents with another 
external system. It can used to identify the types of documents (Invoices, Claim forms etc.) in 
batches or source of document (Email, Scanned etc.) 

These table columns are not Perceptive Intelligent Capture project or application specific and therefore 
cannot be configured in Designer or Verifier or RTS applications.  

By default, these columns will be invisible. To configure the columns’ visibility for Web Verifier, adjust the 
batch columns’ attributes in the batchColumnVisibility section of the web.config file appropriately (refer to 
Appendix A). 

The values of the columns can only be set via the Project Script (PostimportBatch). Check the SQL 
scripts in the installation folder to activate the displaying of those columns. After enabling one or all of the 
additional columns in database, it applies to all application modules. 

The additional columns can be enabled with columns customized. 

For SQL: 

Syntax  
exec sp_SetGlobalApplicationSetting 'ColumnSettingName', 'Column Name to Display', Enabled 
Boolean 

Examples 
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalGroupId', 'User Group', True 

exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalBatchId', 'Batch Group', True 

exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionId', 'Transaction', True 

exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionType', 'Transaction Type', True 

Note For setting up the Group ID column, due to the security control, make sure the group ID is matching 
with the ID created for the users. 

For Oracle: 

Syntax  
exec sp_SetGlobalApplicationSetting ('ColumnSettingName', 'Column Name to Display', Enabled 
Boolean)  

Examples 
exec sp_SetGlobalApplicationSetting ('SysAppBatchColumnExternalGroupId', 'User Group', 1) 

Change Custom Column Names 
After you have enabled new custom columns following the instructions in section Enable New Columns 
for Batch View, you may want to give them more meaningful names.  
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Custom Column Names for Web Verifier 
To change the custom column names for the Web Verifier application: 

1. Navigate to C:\Program Files (x86)\Perceptive\Perceptive Intelligent Capture Web 
Server\Bin\Resources\eng. 

2. Open the file in notepad: Brainware.Verifier.WebClient.resx. 

3. Change the name of the four items below by adjusting the value parameter (highlighted in red in the 
sample below): 

Example 
<data name="TEXT_EXTERNALBATCH_NAME" xml:space="preserve"> 

    <value>External Batch ID</value> 

  </data> 

  <data name="TEXT_EXTERNAL_GROUP_ID" xml:space="preserve"> 

    <value>User Group</value> 

  </data> 

  <data name="TEXT_TRANSACTION_ID" xml:space="preserve"> 

    <value>Transaction ID</value> 

  </data> 

  <data name="TEXT_TRANSACTION_TYPE" xml:space="preserve"> 

    <value>Transaction Type</value> 

For the other application languages, repeat the steps outlined above using the appropriate 
Brainware.Verifier.WebClient.resx file from the appropriate folder under: C:\Program Files 
(x86)\Perceptive\Perceptive Intelligent Capture Web Server\Bin\Resources\. 

Custom Column Names for Thick Verifier Client 
For the Thick Verifier Client, custom column names can be changed via SQL Script. Run the below 
mentioned script by changing the ‘Column Name to Display’ value. 

Syntax  
exec sp_SetGlobalApplicationSetting 'ColumnSettingName', 'Column Name to Display', 
Enabled Boolean 

Example  
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalGroupId', 'User Group', 
True 

Global Application Setting Configuration 
This setting is taken place in SQL server, and it enables/disables Workflow History Reporting, disables 
Batch Deletion in Designer/ MMC, and enables some additional custom columns. 

This feature allows user to enable/disable for Document Level, Field Level, table Level, Classification, 
Document Separation, Learning, etc. 

Note This feature is only available for the Database. 

To execute the setting, complete the following step.  
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1. Launch the SQL Server Management Studio. 

2. Point to the Perceptive Database. 

3. Type the following script: 
exec sp_SetGlobalApplicationSetting 'SysAppHistoryReportingActivatedForDocument', 
'True', True 

• Setting Name is the text name of the setting to be modified for application. 

• Setting value is the text value to configure for it. 

• Status Flag contains True (Setting enabled) or False (Setting disabled). This is disabled by 
default in the current version of Perceptive Intelligent Capture. 

To enable item with Document Level: 
exec sp_SetGlobalApplicationSetting 'SysAppHistoryReportingActivatedForDocument', 
'True', True 

To enable item with Field Level: 
exec sp_SetGlobalApplicationSetting 'SysAppHistoryReportingActivatedForField', 'True', 
True 

To enable Batch Deletion in Designer (Default setting): 
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInDesigner', 'True', 
False 

To disable Batch Deletion in Designer: 
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInDesigner', 'True', 
True 

To enable Batch Deletion in RTS (Default setting): 
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInRTS', 'True', False 

To disable Batch Deletion in RTS: 
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInRTS', 'True', True 

 
Figure 23: Delete Batch Function is disabled in RTS 

It takes immediate effect right after you have configured it in the SQL Server and it applies to all users 
under the Perceptive Database. 
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Security 
Perceptive Intelligent Capture Security 

Project Security 
Perceptive Intelligent Capture contains an internal application security model with 5 project security roles: 

• Administrator: The Administrator’s role (ADM) is to manage users, groups, and user-to-group 
assignments. Administrators install the system, configure applications, and manage data. They also 
design and maintain projects. This role is the most powerful of the roles because it is the highest role 
within Perceptive Intelligent Capture. 

• Learnset Manager: The Learnset Manager (LSM) role is used to define, modify, and maintain the 
global project Learnset. Reference Perceptive Intelligent Capture Designer and Verifier 
documentation for additional information. 

• Supervised Learning Verifier: The Supervised Learning Verifier (SLV) role is to collect and manage 
the local training data. These verifiers are subject-matter experts who can propose Learnset 
improvements. 

• Verifier User: The Verifier role (VER) is to make document correction that could not be automatically 
processed. Typically members of this group are data correction users. 

• Setting Role: The Verifier Settings (SET) role is used to give permission to the Verifier (VER) to alter 
or access the verifier configuration settings. 

• Filtering Role: The filtering role (FLT) is to allow Verifier user to configure custom filtering of batches. 
By application design, FLT users would be able to use the filtering feature even if they do not have 
the SET role. This solution provides more flexibility and security. 

Note Additional information on adding users and groups can be found in the Designer documentation. 
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Project & Windows Authentication Security 
Local workstations and network Windows users can be imported into the Perceptive Intelligent Capture 
project authentication sub-system allowing automatic project authentication with the currently logged in 
Windows user account for all Perceptive Intelligent Capture applications. 

To enable Windows based authentication in Perceptive Intelligent Capture for a desired Perceptive 
Intelligent Capture project: 

1. Open the corresponding project file in the Perceptive Intelligent Capture Designer application 

2. Select Options, Users, Groups and Accounts menu item 

3. Enable Allow Windows Authentication check-box on the Users tab of the Project Authentication 
Settings dialog box. 

 
Figure 24 Perceptive Intelligent Capture Project Security 

When using Database Authentication in Verifier, access rights have to be granted to the verifier user. 

By default, this should be: 

• Read and Write to all database tables 

• Execute rights to stored procedures and functions. 

File System Security 
Although Perceptive Intelligent Capture does provide application-level security, the product relies on 
integrated Windows file system security built into the underlying operating system for file system access.  

Perceptive Intelligent Capture uses operating system files, such as SDP, DAT, and WDC, to store all 
application and project data. A combination of shared and NTFS permissions are used to protect 
application data. 
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NTFS file and folder permissions are used to control the type of access that a user, group, or application 
has to folders and files. This includes everything from reading the contents of a folder or a file to 
modifying a folder’s contents and/or executing individual files. There are five basic NTFS file and six 
folder permissions: 

File 
Permission 

Access Granted 

Read Allows the user or group to read the file and view its attributes, ownership, and the 
permissions set. 

Write Allows the user or group to overwrite the file, change its attributes, view its ownership, and 
view the permissions set. 

Read and 
Execute 

Allows the user or group to run and execute the application. In addition, the user can 
perform all duties allowed by the Read permission. 

Modify 
(CHANGE) 

Allows the user or group to modify and delete a file including performing all of the actions 
permitted by the Read, Write, and Read and Execute NTFS file permissions. 

Full Control Allows the user or group to change the permission set on a file, take ownership of the file, 
and perform actions permitted by all of the other NTFS file permissions. 

 

Folder 
Permission 

Access Granted 

Read Allows the user or group to view the files, folders, and subfolders of the parent folder. It 
also allows the viewing of the folder attributes, ownership, and permissions. 

Write Allows the user or group to create new files and folders within the parent folder, view folder 
ownership and permissions, and change folder attributes. 

List Folder 
Content 

Allows the user or group to view the files and subfolders contained within the folder. 

Read and 
Execute 

Allows the user or group to navigate through all files and subfolders, and to perform all 
actions allowed by the Read and List Folder Contents permissions. 

Modify 
(CHANGE) 

Allows the user to delete the folder and perform all activities included in the Write and 
Read & Execute NTFS folder permissions. 

Full Control Allows the user or group to change permissions on the folder, take ownership of it, and 
perform all activities included in all other permissions. 

The difference between NTFS file and folder permissions is the “List Folder Contents NTFS” folder 
permission. NTFS folder permissions enable system administrators to limit a user’s ability to browse 
through a tree of folders and files. This is useful for securing a specific directory such as an application 
directory. A user must know the name and location of a file to read or execute it when this permission is 
applied to its parent folder. However, in a Perceptive Intelligent Capture environment, client applications 
in the product suite, instead of Windows Explorer, are used to process project data. The intent of file and 
folder permissions is to minimize the probability of accidental or malicious data destruction. 
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Shared permissions serve for purposes similar to NTFS permissions: They help protect files from 
unauthorized access. If you are a member of the Administrators or Power Users group, you can share 
folders on a local computer so that users on other computers can access those folders over the network. 
By assigning shared folder permissions to any shared folder, you can restrict or allow access to those 
folders over the network. Use NTFS folder permissions if the shared folder is located on a NTFS drive. 
NTFS permissions are effective on the local computer and over the network. 

For more information regarding folder permissions, reference 0. 

Access to Project Data 
Perceptive Intelligent Capture uses a hierarchical file structure to store project-related data. The project 
directory is at the highest level of this structure. 

All Perceptive Intelligent Capture components (including services, applications, license engine, and 
users) need appropriate access rights to the project directory and all of its subfolders. 

See section File System Security for details on how to enable access to project data. 

Once Perceptive Intelligent Capture has been installed, configured, and prepared for production, 
appropriate file access security should be applied to the project directory before releasing the 
implementation to the general user community. A correct application of file access security can prevent 
unauthorized access to project data while granting access to authorized users. 

To apply file access security to the Perceptive Intelligent Capture project directory, consider the following 
guidelines. 

 

1. Launch Windows Explorer on the Perceptive Intelligent Capture server (or the server containing the 
project directory). 

2. Locate the project folder, right-click the folder name, and select Properties. 

3. In the Properties dialog box, go to Sharing tab. 

4. Click Share this folder. 

5. In the Share name field, type a name for the share. 

6. Click Permissions. In the Share Permissions dialog box, complete the following tasks, and then click 
OK. 

1. Add the local Perceptive Intelligent Capture group with Full Control permission 

2. Add the local Perceptive Intelligent Capture Users group with Change permission 

3. Add the local Administrators group with Full Control permission 

4. Remove the Everyone group 

7. Go to Security tab. Complete the following tasks and click OK when finished 

1. Add the local Perceptive Intelligent Capture group with Full Control permission 

2. Add the local Perceptive Intelligent Capture Users group with Change permission 

3. Add the local Administrators group with Full Control permission 

4. Remove the Everyone group 

Note The Perceptive Intelligent Capture and Perceptive Intelligent Capture Users groups are local 
groups. The Perceptive Intelligent Capture local group should be created on all Perceptive Intelligent 
Capture servers and RemoteAdmin machines; the Perceptive Intelligent Capture Users local group is only 
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required on the Perceptive Intelligent Capture server storing the project data. For an explanation of these 
groups, see next section. 

Accounts and File Access Security 
Access to project data in a Perceptive Intelligent Capture implementation should be granted using a 
combination of Discretionary Access Control (DAC) and Role-based Access Control (RBAC). 

The Discretionary Access Control model allows the owner of objects or resources (in this context, a 
System Administrator) to control who accesses them and what operations they can perform. For example, 
a System Administrator who creates a share called “Projects” to hold data pertaining to a particular 
Perceptive Intelligent Capture project can control and dictate (per the organization’s security policy and 
business rules) who can access the items within the share. 

The Role-Based Access Control model, also referred to as a non-discretionary model, makes access 
decisions based on the rights and permissions granted to a role or groups, instead of an individual. In this 
model, System Administrators create roles (or groups), and then assign rights and permissions to the role 
(or group) instead of directly to a user; users are then placed into a role (or group) and inherit the rights 
and permissions assigned to the role (or group). 

The following table lists the recommended groups and accounts that should be created for each 
implementation of Perceptive Intelligent Capture: 
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Group/Account 
Name 

Purpose 

Perceptive Intelligent 
Capture ProjectUsers 

Global group containing all users designated as a Perceptive Intelligent Capture 
project designer and/or data verifier within an organization. 

Perceptive Intelligent 
Capture Admin 

Global group containing all users designated as a Perceptive Intelligent Capture 
System Administrator within an organization. This group should be added to the local 
Perceptive Intelligent Capture group on all RTS servers and RTS Remote Admin 
workstations. 

Perceptive Intelligent 
Capture 

Local group used to grant access to local Perceptive Intelligent Capture resources; 
the Perceptive Intelligent Capture Admin global group should be added to its 
membership. Create this group on all Perceptive Intelligent Capture Server and 
RemoteAdmin machines 

Perceptive Intelligent 
Capture Users 

Local group used to grant access to the project directory. Add the global group 
Perceptive Intelligent Capture ProjectUsers to its membership. Create this group on 
the Perceptive Intelligent Capture server housing the project directory. 

Perceptive Intelligent 
Capture RTSsvc 

Service account used to start the Perceptive Intelligent Capture Service Manager. 
This user should be a member of the Perceptive Intelligent Capture Admin global 
group and the local Administrators group on all Perceptive Intelligent Capture servers 
and Remote administration machines. 

The following table lists the groups and accounts, assigned permissions, and the folders/objects on which 
the permissions should be applied for each implementation of Perceptive Intelligent Capture: 

Group/Account 
Name 

Permission 
Type: Shared 

Permission Type: 
NTFS 

Folder/Objects Assigned On 

Perceptive 
Intelligent Capture 

Full Control Full Control C:\Program Files\ 
[company]\ 
[ProjectName] 

Perceptive 
Intelligent 
CaptureUsers 

Change Modify C:\Program Files\ 
[company]\ 
[ProjectName] 

For a comprehensive list of security settings and options, see 0. 

Configure the Service Account for Perceptive Intelligent Capture 

Run Perceptive Intelligent Capture on a Domain Network 
Perceptive Intelligent Capture Runtime Server Service utilizes a Windows Service which runs in the 
Server background. This Service manages the operation of Runtime Server Instances, and processing of 
documents automatically. 

When running Perceptive Intelligent Capture on multiple servers located on a Domain Network, it is 
recommended that the Perceptive Intelligent Capture Runtime Server Service is assigned a Domain user 
against the Windows Service. This will allow Perceptive Intelligent Capture to communicate with all 
servers running the service across the Domain. 
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The Service Account used in Perceptive Intelligent Capture is also given permission to any file/folder 
shares across the servers to allow the Perceptive Intelligent Capture Runtime Server service access to all 
project related files. 

System Monitoring 
The System Monitoring service is used to send email notification to selected users to notify of any errors, 
or warnings, that any Runtime Server instance may raise during its operation. 

The Service User Account used for System Monitoring should have sufficient rights to be able to send 
emails on the server and Domain. 

Email Import and Service User Accounts 
Perceptive Intelligent Capture provides the ability to perform email importing, automatically downloading 
emails from a Mail Box account and importing it into the Perceptive Intelligent Capture system. The 
Perceptive Intelligent Capture Runtime Server Service must have sufficient access rights to be able to 
access the mailbox and download emails for process. 

 

Configure Runtime Components 
Once you install Perceptive Intelligent Capture you must configure the Runtime Service Manager before 
you can use the application.  

Before Configuring Components  
Check the following pre-installation steps before you configure Runtime Components.  

Before starting the Perceptive Intelligent Capture Runtime Service Manager on a license server (a 
machine equipped with a hardware-key intended to provide a shared network copy of the license file to 
other Perceptive Intelligent Capture machines) or a standalone machine (laptop or an autonomous 
Perceptive Intelligent Capture machine), ensure that: 

• A hardware key is installed 

• The corresponding license file for the installed hardware key is copied to the 
…\Perceptive\Components\Cairo directory 

• The demo license file, zCroDemo.lic, is deleted from the …\Perceptive\Components\Cairo directory 

Configure the Runtime Service Manager 
Below are the steps required for configuring the Runtime Service Manager. Administrator rights are 
needed to complete these steps.  

1. Click Start on the lower left of your screen. 

2. Click Run. 

3. At the command window, type services.msc and press Enter. 

4. In the Scope panel, double-click the Perceptive Intelligent Capture Runtime Service Manager. 

5. On the General tab, under Startup type, select Automatic from the drop-down list. 

6. Click the Log On tab. 

7. Under Log on as, select This account. 
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8. Click Browse. 

9. Find and add the domain user with appropriate and sufficient processing network access rights for 
Perceptive Intelligent Capture (such as Perceptive Intelligent Capture RTSsvc), and then click OK. 

10. Type the domain password for the user in the fields provided. 

11. Click Apply and OK and close the Computer Management MMC. 

Configure the RTS RemoteAdmin MMC Snap-in 
The installation of Perceptive Intelligent Capture creates a default console, called Perceptive Intelligent 
Capture Service Manager that you can use to configure the Perceptive Intelligent Capture RTS 
RemoteAdmin MMC snap-in. 

Very Important! 
Before configuring the RemoteAdmin MMC snap-in, make sure that the steps outlined in section 
Configure the Runtime Service Manager have been performed and the Runtime Service Manager is 
started. Unless the service has been started, the MMC will not connect to the machine. 

1. Launch the Perceptive Intelligent Capture Service Manager MMC snap-in by selecting Start > 
Programs > Perceptive>Perceptive Intelligent Capture > Perceptive Intelligent Capture 
Runtime Service > Management Console on the desktop of the target machine. The Perceptive 
Intelligent Capture Service Manager MMC console appears. 

 
Figure 25: The administration console 

2. Right-click the Perceptive Intelligent Capture Runtime Server node and select New Perceptive 
Intelligent Capture RTS Group from the context menu. 

3. On the New Group dialog, type a group name and click OK. 

4. Expand the Perceptive Intelligent Capture Runtime Server node, right-click the group you created, 
and then select New Machine. 
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5. In the Domains drop-down list, select the domain where the machine being configured locates. 

 
Figure 26: Group management of runtime service 

6. On the Group Management dialog box, type the name of the Perceptive Intelligent Capture server 
and click OK. 

 
Figure 27: Administration console with added machine 

7. Right-click the machine name. Select License, and set the license path. 
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8. Right-click the machine name and select New > RTS Instance  

9. On the New RTS Instance dialog, type the instance name and then click OK. The configuration for 
RTS RemoteAdmin MMC snap-in should look like the example in FIGURE 28. 

 
Figure 28: Administration console with instance 

For information on how to configure project settings for a Perceptive Intelligent Capture instance, see the 
Perceptive Intelligent Capture Runtime Server User’s Guide. 

Configure E-mail Import 
Below are the steps required to configure the E-mail Import feature for Microsoft Office 2003. They may 
be slightly different for other versions of Microsoft Office.  

1. Launch the Windows Control Panel and select the Mail option  

Note Microsoft Outlook must be installed before this option appears in the Control Panel.  

2. Click Show Profiles. Click Add,create a new profile named RTS_Import, and click OK.  

3. Select Add a new E-mail account and click Next. Select Microsoft Exchange Server. 

4. Enter the name of your Microsoft Exchange Server. Switch off Use Cached Exchange Mode. Enter 
the User Name and click b to make sure that mailbox is recognized.  

5. Click Next then click Finish to create the account and close the wizard. 

6. Open the .\Perceptive\Perceptive Intelligent Capture folder in Windows Explorer and create a 
batch file containing the following line: DstHost.exe /TestMailUI. Run the batch file. The Outlook 
logon screen should appear. 

7. Enter [your domain name]\[your user name] as the user name and your password. Check the 
Remember password option otherwise your RTS service may not work. 

8. Open the latest I_YYYYMMDD_Perceptive Intelligent Capture RuntimeServiceHost_PID.log file 
in the .\Perceptive\ Perceptive Intelligent Capture\Log folder and verify whether the login was 
successful by checking for the message: Managed to open the folder Inbox or any corresponding 
errors.  
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9. Create and run another batch file containing the following line: DstHost.exe /TestMail. You should 
get the same message in the log file as in the previous step, such as, Managed to open the folder 
'Inbox', but without any dialog box prompting you for the user name and password. 

10. See the Perceptive Intelligent Capture Runtime Server Guide to complete the configuration process. 

Advanced Logging 
The standard Runtime Server Log includes System Level Resource information and, in the event of a 
system crash or failure, special error logs. 

System Resource Logging 
In the Perceptive Intelligent Capture\bin\Log folder, the log files for the different Perceptive Intelligent 
Capture components can be found as following: 

• V_ log file for Verifier messages, e.g. any custom script errors would be logged there. 

• H_ log file for Runtime Server messages. 

• VA_ log file for Advanced Verifier messages. 

• L_ log file for Learnset Manager messages, e.g. when the user triggers document learning, or when 
a backup of the Learnset is taken, etc. 

• D_log file for Designer messages (including scripting errors). 

• U_log file for Unknown/External application messages. 

• S_log file for Standard Service Manager messages. 

• The I_ log files are component log files for all applications and are written to by the application during 
the normal running. 

Examples for file name syntax, e.g. for the Runtime Server log file: 

[Application directory]\bin\Log\H_<instance name>_yyyymmdd.log 
For example: 
C:\Program files\Perceptive\Perceptive Intelligent Capture\bin\Log\H_Test_20100203.log 

Standard Service Manager log file: 

[Application directory]\bin\Log\S_yyyymmdd.log 
For example: 
C:\Program files\Perceptive\Perceptive Intelligent Capture\bin\Log\S_20100203.log 

The following System Resource information has been added to the log files. 

• Available physical memory (in kb). 

• Used physical memory (in kb). 

• Available virtual memory (in kb). 

• Used virtual memory (in kb). 

• Virtual memory used by this RTS host instance process (in kb). 
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• Physical memory used by this RTS host instance process (in kb). 

• Handles used by the process (in number of handles). 

• GDI resources used by the process (in number of handles). 

• User Objects used by the Process (in number of Objects). 

Using the following format: 

Entry Nr. Entry Description 

1 Type of message (info, warning, error, etc) 

2 Severity of message 

3 Time logged 

4 Process ID (PID) 

5 Overall used/available physical memory 

6 Overall used/available virtual memory 

7 Used physical/virtual memory by this Runtime Manager 

8 Process handles used by this Runtime Manager 

9 GDI resources/UserObjects used by this Runtime Manager 

10 Message Description 

 

S_log example: 
[Info]   |30| 00:35:26.146 |  2628 | 2663792k/14110392k | 2983264k/24429476k | 51660k/18932k | 
154 | 4/14 | Sent '13' to Host '5.2FullSetup-RTS' Conn: 1 

H_log example 
[Info]   |20| 01:00:57.656 |  5584 | 1005944k/15768240k | 1097012k/26315728k | 8276k/7004k | 84 | 
4/5 | Username: SYSTEM, Computername: WIN-RSL5FCPK7A4 

 

Crash / Failure Logging 
In the case of a System or Application Crash or Failure an additional error log file will be created with a 
format: 
C_<Process ID>_yyyymmdd.log  

This will log crashes under the following circumstances. 

• Import Crashes - The log file will have stack information specific to the status of the system when the 
crash/failure occurred. 
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• OCR Engine Crashes - The log file will have a "ReadZone" entry for the specific OCR engine for 
which the crash occurred and stack information specific to the status of the system when the 
crash/failure occurred. 

• Classification Engine Crashes - The log file will have a "Classify" entry for the specific Classification 
engine for which the crash occurred, the specific Class name where the crash occurs, and stack 
information specific to the status of the system when the crash/failure occurred. 

• Extraction Engine Crashes - The log file will have an "EvalZone" entry for the specific Extraction 
engine for which the crash occurred, the field where the crash occurs, and stack information specific 
to the status of the system when the crash/failure occurred. 

• Export crashes - The log file will have a "StepExport" and stack information specific to the status of 
the system when the crash/failure occurred. 

• Clean-up crashes - The log file will have a "ProcessDocumentsCleanUp" and stack information 
specific to the status of the system when the crash/ failure occurred. 

• Script Events - The name of the script event, which could be project level or a certain class. For script 
events on field level, the field name will be added to the crash/failure log. 

Auto-Update  
Description 

How the Automatic Update Works 
The auto update feature allows the Administrator to update automatically Perceptive Intelligent Capture 
software versions with latest available service updates on different workstations where Perceptive 
Intelligent Capture applications are running. For this purpose, it is required to set up a “Shared Network 
Folder” where the new service updates are to be placed. 

The workstations must have sufficient file access permissions to access this shared directory. 
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Furthermore, a Local Update Folder has to exist for each workstation, where automatic updates are to be 
configured. Through this directory, the system will check which software builds have already been 
installed. 

There are three files to be copied to the Shared Network Folder to enable automatic updates: 

• One system file (called “Build Level” file for further reference) identifies the build level of the service 
update to deploy automatically (for example, “B4117.installed“). 

• The service update to deploy automatically. (It is recommended to define a unique name associated 
with execution of service update installations, for example “Setup.exe“.) 

• One batch file for execution of the service update in Silent Mode ("InstallRemote.bat“). 

When starting the Verifier (or Designer/RTS applications) the batch file checks whether the same “Build 
Level” file located in the “Shared Network Folder is already available in the Local Update Folder. 

1. If this is not the case, the "InstallRemote.bat" is invoked. After completion of the silent installation, the 
“Build Level” file from the Shared Network Folder is going to be copied to the Local Update Folder 
directory and the Verifier (or the other desired application) is going to be started. 

2. In case the same “Build Level” file is already available in the Local Update Folder, the silent update 
step is going to be skipped and only the launching of the application is going to take place. 

3. To auto-update the Runtime Server (RTS) software version, the RTS service has to be stopped first. 
It is recommended to apply this operation when the RTS is not loaded with the document processing 
activities. For this purpose the Windows "Winat" function can be used, which can be configured as 
follows. 

• Stop the RTS service at the specific desired time (e.g., via usage of the "Stop RTS running as NT 
Service.bat" from the application directory of Perceptive Intelligent Capture). 

• Start the auto-update feature (the file "AutoInstall.bat" from the Perceptive Intelligent Capture 
application directory contains all required instructions).  
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Note The enclosed file paths have to be adjusted manually. 

• Start the RTS service at the desired time (e.g., via usage of the "Start RTS as NT Service.bat" 
from the application directory of Perceptive Intelligent Capture). 

The used batch files are going to be created during the full setup installation of Perceptive Intelligent 
Capture. In case the Auto Update feature was not configured during the installation, the used file paths 
have to be entered/adjusted in the following batch files (after the installation): “StartIfNotInstalled.bat“, 
“AutoInstall.bat“. To enable the auto update feature for the Verifier and Designer applications, they have 
to be started via the corresponding “DstVer_AutoUpdate.bat" (or “DstDsr_AutoUpdate.bat") from the 
Perceptive Intelligent Capture application directory. 

Configure Auto Update in Perceptive Intelligent Capture Setup 
During the Perceptive Intelligent Capture 5.6 installation, the setup will show a dialog box for configuring 
of the Auto Update feature. 

To configure the auto update during the installation, the Shared Network Folder path has to be known 
before launching the Perceptive Intelligent Capture setup. The administrator can also activate the 
automatic update for Verifier and/or Designer applications using the corresponding Designer and Verifier 
check-box controls available in the dialog (by default, both are deactivated).  

The options have the following implication: 

Activation of Designer and/or Verifier options: The program shortcuts do not call the corresponding 
application directly any longer. Instead they use the generated (by the setup) batch files 
“DstDsr_AutoUpdate.bat“ and/or “DstVer_AutoUpdate.bat“ correspondingly.  

Note These options can be activated only if the entered “Shared Network Folder“ path is valid. 

Entering of the Shared Network Folder path: The setup will use this path when generating the batch files 
for auto update function (See section How the Automatic Update Works above). 

Manual Configuration of the Auto Update Function 
In case the Auto Update feature was not properly configured during the Perceptive Intelligent Capture 5.6 
installation (for example, due to the reason that exact location of the Shared Network Folder was 
unknown at the point of the installation), it is still possible to configure it manually afterwards. The 
following steps are going to be required. 

Edit the “AutoInstall.bat” Batch File 
The path Shared Network Folder has to be entered in the “AutoInstall.bat“. For this purpose, edit the 
“AutoInstall.bat“ batch file using, e.g., Windows Notepad application (right-click the “AutoInstall.bat“ file in 
Windows Explorer, select Edit menu item). 

 

@echo off 

REM 
=======================================================================================================
== 

REM This Batch file checks the Shared Network Install folder ("SHAREDNETFOLDER" variable) for available 

REM software service updates. 

REM Please adjust the "SHAREDNETFOLDER" variable with your network path, where new service updates are 

REM going to be placed for automatic installation by Verifier and/or Runtime Service workstations. 

REM 
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REM Example: \Your File ServerYour Perceptive Intelligent Capture Service Update Share 

REM 

REM "ACTIVEDIR" variable: Location of this batch file (generated automatically by the Perceptive 
Intelligent Capture setup). 

REM 

REM (c) 2008 Perceptive Software, Inc. 

REM 
=======================================================================================================
== 

SET SHAREDNETFOLDER ="\\YourNetworkInstallServerName\YourInstallShareName" 

SET ACTIVEDIR ="C:\Programme\Perceptive\Perceptive Intelligent Capture" 

IF EXIST %SHAREDNETFOLDER %\*.installed GOTO NEW_SU 

echo no.updates.available.root 

GOTO END 

:NEW_SU 

CD %SHAREDNETFOLDER % 

for %%1 in (*.installed) do Call %ACTIVEDIR %\StartIfNotInstalled %%1 %SHAREDNETFOLDER % %ACTIVEDIR % 

CD %ACTIVEDIR % 

:END 

 

Change the content of the variable “SHAREDNETWORKFOLDER” to the network location of the new 
service updates that is going to be used as the master location of the software setups for Auto Update 
feature. 

Change Shortcuts 
The shortcuts used to start Designer and/or Verifier applications (Available in Windows Start menu and/or 
on the desktop) invoke the corresponding programs directly, in case the Auto Update function was not 
configured during the setup. 

To adjust this, replace the target file “DstDsr.exe“ (or “DstVer.exe“ for the Verifier application’s shortcut) 
with the batch file DstDsr_AutoUpdate.bat“ (or “DstVer_AutoUpdate.bat“) in the Properties of the 
corresponding application’s shortcut (Right-click the shortcut and select the Properties menu item). 

Usage 
The Auto Update feature can be used for automation of the Perceptive Intelligent Capture installation 
process and can save time in administration efforts to deploy future software update on, e.g., 100 
different production developments, and testing workstations and servers where Perceptive Intelligent 
Capture is running. 

Enable Additional OCR Engine Languages 
Perceptive Intelligent Capture supports many OCR engine languages. The FineReader engines support 
Asian languages such as Japanese, Chinese, Thai, and Korean. The main languages, English, French, 
German, Spanish, and Italian are enabled by default, but for some OCR engines you can request 
additional recognition languages at Perceptive. 

Perceptive will confirm that the requested language is effectively supported by the desired OCR engine 
and will deliver special custom language files in this case. 
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To Enable a Language for an OCR Engine 
A language can only be processed by Perceptive Intelligent Capture if it is installed on the server 
machine, and if it is present in the FineReader directory: 

1. Exit all Perceptive Intelligent Capture applications. 

2. On the Perceptive Intelligent Capture servers, stop the Perceptive Intelligent Capture Runtime Server 
services. 

3. Copy the custom language file(s) received from Perceptive to the .\Langfile sub-folder on your local 
system. 

4. Copy the language file to the appropriate FineReader folder: 

5. for instance: .\ Perceptive\Components\Cairo\Finereader10 on all configured Perceptive Intelligent 
Capture machines. 

6. Restart the Perceptive Intelligent Capture Runtime Server services. 

7. Restart the client application. 

Note If not already done, you first have to enable the support of double byte and extended ASCII 
character sets, (Greek, CJKT, Russian, Hebrew) for your system. The steps depend on your operating 
system. 

To add Input Language for Windows 7 
1. Select Start > Control Panel > Clock, Language, and Region > Region and Language. 

2. Click the Keyboards and Languages tab. 

3. Click Change keyboards. 

4. Under Installed services, click Add. 

5. Double-click the language you want to add, double-click Keyboard. 

6. Select the text services options you want to add. 

7. Click OK to confirm. 

To add Input Language for Windows XP 
1. Select Start > Control Panel > Language and Regional Options. 

2. Select the Languages tab. 

3. Check the two check boxes for Supplemental language support. 

4. Click Apply. 

5. Reboot the machine. 

To add Input Language for Windows Vista 
1. Select Start > Control Panel > Clock, Language, and Region > Regional and Language Options. 

2. Click the Keyboards and Languages tab. 

3. Click Change keyboards. 

4. Under Installed services, click Add. 
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5. Double-click the language you want to add, double-click the text services you want to add. 

6. Select the text services options you want to add. 

7. Click OK to confirm. 

To add Input Language for Windows 2008 
1. Select Start > Control Panel > Regional and Language Options. 

2. Click the Keyboards and Languages tab. 

3. Click Change keyboards. 

4. Under Installed services, click Add. 

5. Double-click the language you want to add, double-click the text services you want to add. 

6. Select the text services options you want to add. 

7. Click OK to confirm. 

To add Input Language for Windows 2003 
1. Select Start > Control Panel > Regional and Language Options. 

2. Select the Languages tab. 

3. Under Supplemental language support, check the two check boxes. 

4. Click OK or Apply. 

5. Reboot the machine. 

 

Use Perceptive Intelligent Capture Licenses 
To use Perceptive Intelligent Capture, you must have a runtime license. The license is stored in a file with 
the extension *.lic. This file is located in the \Components\Cairo directory of the Perceptive Intelligent 
Capture installation. The license file can be updated incrementally as new components are purchased.  

To check the current license status, use SCBLibVersion.exe (…\Components\Tools). From the menu, 
select View>Components Licensing Info to display a list of valid licenses. 

Only licensed options are available in Perceptive Intelligent Capture.  

The Perceptive Intelligent Capture installation contains a demo license file, ZcroDemo.lic, which is valid 
for several weeks. When you receive your permanent license, copy the *.lic file to the license path and 
remove the demo license file. 

Perceptive’s licensing model uses a combination of a license file and a corresponding hardware key. For 
a standalone installation, the hardware key can be attached to a local machine that contains both the 
server and client components of the Perceptive Intelligent Capture product suite. 

The Perceptive licensing model is designed for a distributed client/server environment where scalability is 
paramount. In this type of environment, a machine designated as the license server houses both the 
hardware key and the original license file. The server generates a centrally located network license file 
that is used by all other servers and clients that are part of the Perceptive Intelligent Capture 
implementation. 
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For more information on the Perceptive Intelligent Capture licensing model, refer to the Product Licensing 
Guide on the installation CD. The document can also be found on the installation folder path 
…\Perceptive\Perceptive Intelligent Capture.   
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Appendix A Web.Config Options and Associated Resource 
File Parameters 

The table below contains some items which can be modified in the Web.Config with regards to 
enabling/disabling/customizing certain features. 

Option Default 
Value 

Description 

ADOCommandExecutionTi
meOut 

Web 
Verifier 

Optional attribute. Timeout in seconds for database stored 
procedures execution. If not specified timeout from database 
connection string is used. 

 

<client ADOCommandExecutionTimeOut=10></client> 

AllowAccessToDocumentsT
oIndexOnly 

false This option controls whether navigation is enabled only for 
documents for indexing (those with states from enabled 
workflow input states).  

This option only takes effect when "Disable navigation to valid 
documents" is set to True in settings. When set to False (or not 
included in web.config) WVC works as before allowing 
navigation to out-of-workflow documents.  

 

assembly  Note This attribute is not configurable. 

 

Required attribute. Assembly contains custom user provider 
class. 

 

<user.controller> 

<userProvider.assembly="Brainware.Verifier.WebC
lient" ... 

</user.controller> 

 

Required attribute. Assembly containts custom logger provider 
class. 

<system.logger> 

<userProvider.assembly="Brainware.System.Logger
" ... 

</system.logger> 
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Option Default 
Value 

Description 

batchColumnVisibility Web 
Verifier 

Configuration of additional columns in the Batch View: 

Setting this attribute to true will display the External Group ID 
batch column in WVC 

externalGroupIdColumn visible="true"/ 

 

Setting this attribute to true will display the External Batch 
Name column in WVC 

externalBatchNameColumn visible="true"/ 

 

Setting this attribute to true will display the Transaction ID batch 
column in WVC 

transactionIdColumn visible="true"/ 

 

Setting this attribute to true will display the Transaction Type 
batch column in WVC 

transactionTypeColumn visible="true"/ 

BatchViewPageSize 20 The number of batches to display on Web Verifier in the batch 
list. Any batches exceeding that count are divided into other 
navigation pages. 

The default value is 20, allowing for up to 20 batches to be 
shown in the Web Verifier batch list. 

 

Example 

 

<add key="BatchViewPageSize" value="20"/> 

 

cacheSize  A parameter in the web.config that allows users to specify the 
number of documents to cache when working on a batch of 
documents. Document pre-loads workdoc objects to speed up 
opening of next documents within the batch.  

Within the web.config file, set the value for the cacheSize 
property within the 
<system.controllers>/<document.controller>/<document> 
section.  

<document cacheSize="10" maxPagesToPreload="4"> 

It is not possible to disable the pre-loading feature, but it is 
possible to minimize the number of pre-loaded documents to 2: 
one current and one pre-loaded. 
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Option Default 
Value 

Description 

class  Required attribute. Custom user provider. 

 

<user.controller> 

<userProvider.class="Brainware.Verifier.WebClie
nt.Core.WebUserProvider" ... 

</user.controller> 

 

Required attribute. Custom logger provider. 

<system.logger> 

<userProvider.assembly="Brainware.System.Logger
.LoggerFactory" ... 

</system.logger> 

 

 

connectionStrings  Configuration connects to database. 

<connectionStrings> 

<add name="Entities" connectionString="…" 
providerName="System.Data.EntityClient" /> 

  </connectionStrings> 

DocumentViewPageSize 4 The number of folders to display in the Document Tree view, 
when selecting Show Selected Batch. The default value, 4, 
denotes 4 folders to display in Show Selected Batch view; any 
additional batches are shown in subsequent navigation panels. 

 

Example 

 

<add key="DocumentViewPageSize" value="4"/> 

 

EnableProfiler  Enables the Web Verifier profiler. 

<add key="EnableProfiler" value="true|false" /> 

The profiler collects and records time taken by user actions 
such as commands and their internal sub-operations. 
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Option Default 
Value 

Description 

formEvents  Required attribute. Enable/disable focus changed event on 
fields on the Verification view. 

<focusChanged enabled="true|false"/>  

Controls firing of FocusChanged event on Enter key press in a 
field. Defaults to true, if web.config does not have this setting, it 
is considered to be turned on. This setting has no effect on 
FocusChanged event in case <mouseClicked> is set to true. 

Required attribute. Enable/disable mouse click event on fields 
and table on the Verification view in Indexing mode. 

<mouseClicked enabled="true"/> 

 

Required attribute. Enable/disable tabPressed event on fields 
and table on the Verification view in Indexing mode. 

<tabPressed enabled="true"/> 

Required attribute. Enable/disable itemCopied event. 

<itemCopied enabled="true"/> 

Required attribute. Enable/disable table cell select event. 

<tableCellSelected enabled="true"/> 

 

httpHeaderBasedSso  Enables the Single Sign-On (SSO) user authentication using an 
httpHeader sent by an SSO service. The header value contains 
the SSO authenticated user name..  

This parameter is used by the SSO service to send logged in 
user name. 

enabled="true": setting the enabled attribute to true 
enables the Web Verifier SSO feature. 

Note On a system using standard authentication the 
“enabled” setting should be set to ‘false’. 

loginHeader="login" – the loginHeader value corresponds 
to the HTTP header attribute name that contains the SSO 
authenticated user. 

 Example: 

<httpHeaderBasedSso loginHeader="remoteUser" 
enabled="true"/> 

inactiveUserTimeout  Required attribute. It is not used to control user session timeout. 
The user session timeout is controlled by the <sessionState 
Timeout> parameter. 
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Option Default 
Value 

Description 

inspectionServerTimeout  Required attribute. Time of the periodical ping the IIS server by 
the process in separate mode. 

<system.project> 

<project. inspectionServerTimeout ="00:00:20" 
... 

</system.project> 

 

inspectionTimeOut  Required attribute. It is not used to control user session timeout. 
The user session timeout is controlled by the <sessionState 
Timeout. parameter.. 

instanceName Web 
Verifier 

The name of the Web module that will be shown to have access 
the batch list. 

 

Example 

 

<client instanceName="Web Verifier"></client> 

 

LanguageDisplayName_[IS
O] 

 This optional set of keys is located in the <appSettings> section 
of the web.config file. 

The [ISO] part of the key needs to be replaced by the three 
letters name of the folder in the Web Verifier resources folder. 

This key can be used to customize the language display names 
of the language selection drop-down menu. 

Example 

To display the correct string for Simplified Chinese, the 
following should be added: 

<add key="LanguageDisplayName_ZHO" value="中文简

体"/> 

Note As soon as this parameter is defined it will override the 
system language name. 
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Option Default 
Value 

Description 

licensePath “C:\My 
Shared 
License\Ru
ntime.lic” 

The location of the shared license file, reference documentation 
regarding configuration. This should point to the License Share 
file. 

 

Example 

 

<project licensePath="C:\My Shared 
License\Runtime.lic"   mpdDistance="19" 
mpdThreshold="60"/> 

 

loadInSeparateProcess True Required attribute. Read only. The value is 'True' only. 

maxPagesToPreload  This setting defines the number of pages to be pre-loaded for a 
document. 

According to the settings made, the following actions will be 
triggered on page images in the background when a document 
is loaded: 

• Pre-loading 

• Converting to JPEG 

• Saving to the database 

 

<document cacheSize="10" maxPagesToPreload="4"> 
 

First and last pages are always pre-loaded, remaining cache 
slots are filled with pages that have field candidates starting 
from the lower index. 

pathToProjectExe “BW \ 
Perceptive 
Intelligent 
Capture \ 
bin\” 

The location of the Perceptive Intelligent Capture Designer 
module (DstDsr.exe). 

 

Example 

 

pathToProjectExe="C:\Program 
Files\Perceptive\Perceptive Intelligent 
Capture\bin\" 
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Option Default 
Value 

Description 

priority ERROR Set this attribute to identify tracing level. Options are,  

- DEBUG: Full tracing of information and errors. 

- ERROR: Errors only. 

 

Example 

 

<priority value="ERROR"/> 

 

reinitScript True By default, this attribute is always set to true. This will recover 
the script engine whenever a script error occurs in Web Verifier 
application.  

remoteObjectRenewalTime
out 

60 Optional attribute. Remote object references are renewed at 
this time period (in seconds). Defaults to 60. Minimum accepted 
value is 30. The lower the number the faster unused objects 
free memory but this can lead to errors for long running 
commands. One can increase this value if some actions (i.e. 
field validation) take a while to finish with remoting error. 

 

Note This value should be set in both web application config file 
and Brainware.System.Project.exe config file 

 

<client remoteObjectRenewalTimeout 
=45></client> 

 

sessionHeader headerNam
e 

Name of the HTTP header used by the SSO service to send its 
user 
session ID. 

This is SSO service dependent.  

Example 

headerName is "ShibSessionId" for a Shibboleth provider. 

sessionState Timeout 20 The sessionState Timeout parameter controls the timeout for a 
user session. The value represents the number of minutes that 
a user is allowed to be inactive before the session is ended. 

Note Session timeout should be set to a value less than that of 
the SSO session. Refer to the product documentation of your 
SSO provider for details how to configure the SSO session 
duration. 
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Option Default 
Value 

Description 

ShowExtendedErrorMessag
es 

True Set this attribute to true to enable stack trace information in the 
error messages appearing in Web Verifier. Messages are 
written to the Trace Log file. 

Allowable values are True and False. 

 

Example 

 

<add key="ShowExtendedErrorMessages" 
value="true"/> 

 

slogan Empty A text message that can be displayed on the Web Verifier 
browser header with corporate messages / announcements / 
Corporate Slogan. 

 

SYSTEM_LONG_DATE_F
ORMAT 

Empty This special XML key is located in each resources /[3-letters 
language]/Brainware.Verifier.WebClient.resx file. 

This key contains the date formatting pattern for the last access 
date column presentation within the batch list for that language. 
It is optional, and if set to Empty, then the system default 
formatting is applied. 

For Chinese Traditional and Simplified languages the date 
format to be used is YYYY-MM-DD, and the time format is 24 
based without any Chinese characters. 

Example for the Chinese: 
    <data name="SYSTEM_LONG_DATE_FORMAT" 
xml:space="preserve"> 
    <value>yyyy-MM-dd, hh:mm:ss</value> 
  </data> 

Trace log/ debug file 1  It keeps the debug/ trace log file under X size. Once the X size 
is reached, the log is recycled/ deleted and a new log is 
created. 

 

For example, below its set to 100kb, as soon as the trace.log 
file went over 100kb the log file size changed to 0kb and new 
log messages were written. 

<appender name="RollingFile" 
type="log4net.Appender.RollingFileAppender,log4
net"> 

<layout 
type="log4net.Layout.PatternLayout,log4net"> 
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Option Default 
Value 

Description 

Trace log/ debug file 2  When the file reaches X size, it is archived as trace.log.1 and a 
new trace.log will be created. When the trace.log exceeds size 
once more, trace.log.1 becomes trace.log.2 and the existing 
trace.log becomes trace.log.1, again a new trace.log will be 
created. 

trace.log.1 

config 

 

<appender name="RollingFile" 
type="log4net.Appender.RollingFileAppender,log4
net"> 

<layout 
type="log4net.Layout.PatternLayout,log4net"> 

usePath  Required attribute. Enable/disable using pathToProjectExe 
parameter. Set this attribute to false to set pathToProjectExe 
parameter is current directory. 

waitLoadTimeOut  Required attribute. Timeout for initial loading of project.exe. 
This parameter is used with enable option: 
loadInSeparateProcess = true 
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Appendix B File Permission Matrix 
The table below displays the various file permissions that are used within Perceptive Intelligent Capture. 

Role/Group Description 

Administrators Administrator user with full access rights to all application modules and features. 

Developers The groups of users that develop, maintain, and enhance projects. 

Learnset Manager Typically one user in the organization responsible for maintaining the project Learnsets. 

Advanced Verifiers Several users responsible for identifying documents for improvements to the project 
Learnset. 

Standard Verifiers Data entry clerks responsible for document correction. 

RTS Service User The service account responsible for running the service for automatic document 
processing. Configured only on the Server machines. 

 

Directory Groups NTFS Permissions 

    Full 
Control 

Modify Read & 
Execute 

List 
Folder 
Content 

Read Write No 
Access 

License Share Administrators 
Developers 
Learnset Manager 
Advanced Verifiers 
Standard Verifiers 
RTS Service User 

       

Root Batch 
Folder 

Administrators 
Developers 
Learnset Manager 
Advanced Verifiers 
Standard Verifiers 
RTS Service User 

       

Common Folder Administrators 
Developers 
Learnset Manager 
Advanced Verifiers 

       

  Standard Verifiers 
RTS Service User 

       
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Directory Groups NTFS Permissions 

    Full 
Control 

Modify Read & 
Execute 

List 
Folder 
Content 

Read Write No 
Access 

Global Project Administrators 
Developers 
Learnset Manager 
RTS Service User 

       

  Advanced Verifiers 
Standard Verifiers 

       

Local Project Administrators 
Developers 

       

  Learnset Manager 
RTS Service User 
Standard Verifiers 

       

  Advanced Verifiers        

Local Learnset Administrators 
Developers 

       

  Learnset Manager 
RTS Service User 
Standard Verifiers 

       

  Advanced Verifiers        

Global Learnset Administrators 
Developers 
Learnset Manager 
RTS Service User 

       

  Advanced Verifiers 
Standard Verifiers 

       

ASE Pool Administrators 
Developers 
RTS Service User 

       

  Learnset Manager 
Advanced Verifiers 
Standard Verifiers 

       

ASSA CSV File Administrators 
Developers 

       
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Directory Groups NTFS Permissions 

    Full 
Control 

Modify Read & 
Execute 

List 
Folder 
Content 

Read Write No 
Access 

RTS Service User 

  Learnset Manager 
Advanced Verifiers 
Standard Verifiers 

       
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Appendix C Registry Options 
The table below contains some items which can be modified in the Registry with regards to 
enabling/disabling/customizing certain features. 

Option Default 
Value 

Description 

DumpProjectScriptCod
e 

N/A This key is available to allow Support/Certified System Administrator / 
Professional Services to carry out advanced troubleshooting on any issues 
with script running on the Web Verifier. 

 

To create the registry key to provide script dumps, follow the instructions 
outlined below: 

1. Launch Windows Registry Editor 

  

2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Perceptive (or 
HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Perceptive for 
64 bit systems), and Cedar location. 

  

3. Create a new REG_DWORD (DWORD Value key) and call it 
DumpProjectScriptCode 

  

4. Modify the new key created and enter the one of the following values: 

3 – to enable this feature for script page export. 

  

0 – to disable this feature. 

 

With the feature enabled the scripting engine files can be used to review 
any compilation problems, this is an advanced feature and requires 
advanced knowledge of the product. 
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Option Default 
Value 

Description 

ErrorTraceDir N/A The ErrorTraceDir registry key is available for those customers who wish to 
place the component tracing logs in a different location than the default 
Perceptive Intelligent Capture\bin\log folder. The registry key allows the 
administrator to place the logs in a specific folder location separate from 
the core product logs. 

  

The registry setting is only applicable for the component logs, not for the 
core product logs. 

 

To configure a new location for Component Logs, follow the instructions 
outlines below: 

1. Launch Windows Registry Editor 

  

2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Perceptive (or 
HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Perceptive for 
64 bit systems), and ErrorTrace location. 

  

3. Create a new REG_SZ (String Value key) and call it ErrorTraceDir 

  

4. Modify the new key created and enter the filepath location for component 
logs to be entered. Verify that the path entered exists and the service 
account/user has sufficient permissions to write to that location. 

  

 For the change to take place, exit all Perceptive Intelligent Capture 
application, and stop any services running on the machine related to 
Perceptive Intelligent Capture, then launch the application and all new 
component logs will be written in the desired location. 
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Option Default 
Value 

Description 

LanguageSupportWor
kflowSettingsVisible 

N/A This registry key is used within Perceptive Intelligent Capture to allow the 
developer to utilize advanced Language Support configuration and setting. 
This additional feature can be enabled via the Registry using the steps 
outlined below: 

  

1. On the server/machine where Designer is installed and used, launch the 
Windows Registry Editor. 

  

2. Navigate to HKEY_LOCAL_MACHINE, SOFTWARE, Perceptive (or 
HKEY_LOCAL_MACHINE, SOFTWARE, Wow6432Node, Perceptive for 
64 bit systems), and Cedar location. 

  

3. Create a new REG_DWORD (DWORD Value key) and call it 
LanguageSupportWorkflowSettingsVisible 

  

4. Modify the new key created and enter the one of the following values: 

a. 1 – to enable this feature to allow the developer to configure advanced 
options for language conversion. 

  

b. 0 – to disable this feature. 

 

For the change to take place, exit all Perceptive Intelligent Capture 
application, and stop any services running on the machine related to 
Perceptive Intelligent Capture, then launch the application and all new 
component logs will be written in the desired location. 

  

To view the advanced options in Perceptive Intelligent Capture Designer,  

1. Launch Designer application 

2. From the Options Menu select Settings 

3. Navigate to the Definition tab and new settings will display. 

 

  

With the settings showing, the developer can utilize additional language 
features which will allow them to convert words/etc to extended ASCII 
character set. 
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Option Default 
Value 

Description 

ASEnginePoolAllowed 

CharDifference 

N/A In certain instances some duplicates in the ASE/ASSA search may not be 
returned from the vendor/customer search. In these cases it may be that 
the ASSA engine perceives these as duplicates of existing entries. 

  

There is a configuration step that can be undertaken which can return the 
suspected duplicates as well. This may slightly increase the results of the 
ASE pool, but also return potential items which were not returned in the 
original search. 

  

To configure the ASE pool to return additional likely results: 

• Launch Registry Editor 

• Navigate to HKLM\Software \Perceptive\Cedar (or 
HKLM\Software\Wow6432Node\Perceptive\Cedar for 64 bit systems) 

• Create a new DWORD registry variable for 
ASEnginePoolAllowedCharDifference 

• Close the Registry Editor 

  

Reanalyze the document once more and any missing entries should now 
appear. 
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Option Default 
Value 

Description 

HideBatchReleaseDial
og 

0 This key allows Support/ Certified System Administrator/ professional 
Services to disable the Batch Release dialog box within the Verifier, where 
the business does not require prompting users on next task. The registry 
value can be used to determine the next action carried out by users. 

 

The default action of the Batch Release dialog box is to verify the next 
invalid batch. When the dialog is suppressed, this value is maintained. To 
change to a different action, use the Batch Release dialog box once, then 
change the setting accordingly and click OK. 

 

To create the registry key to suppress the Batch Release confirmation 
screen, follow the instructions below: 

Launch Windows Registry Editor 

Navigate to HKEY_LOCAL_MACHINE\SOFTWARE \Perceptive\ Cedar (or 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\ Cedar 
for 64 bit systems) 

Create a new REG_DWORD (DWORD Value key) and call it 
HidebatchReleaseDialog 

Modify the new key created and enter the one of the following values: 

0- to enable the confirmation screen (default) 

1- to disable/ hide the confirmation screen 

 

For the change to take place, exit all Perceptive Intelligent Capture 
application, and then launch the application again. 

 

To view that the change has been implemented: 

1. Launch Verifier 

2. Verify the batch to completion – no dialog box should appear 

 

This setting is available from version 5.3. 
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Option Default 
Value 

Description 

All 1 The ErrorTrace registry Key was introduced into core product logs to 
provide additional trace information on any errors or warnings in the 
system. The default value after installation is to record errors only related 
details. 

 

Modify the registry values to set the value from 0 to either 1, 2, or 3 

1-Only Errors 

2-Errors & Warnings 

3-Errors & Warnings&Information 

 

To configure ErrorTrace All value, complete the following steps: 

1. Launch Registry Editor 

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE 
\Perceptive\ErrorTrace (or 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\Er
rorTrace for 64 bit systems) 

3. Create a new DWORD registry variable for All, set to the appropriate 
value of either 0, 1, 2, or 3. 

4. Close the Registry Editor 
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Option Default 
Value 

Description 

MaximumDiskspace-
UsageMB 

N/A This registry value controls the amount of disk space allocated for 
component level logs on this server / workstation in MB. Setting this value 
to “0” has the same effect as if the value is not created at all, which is 
“deactivated”. 

 

To configure the ASE pool to return additional likely results, complete the 
following steps: 

1. Launch Registry Editor 

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE 
\Perceptive\ErrorTrace (or 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\Er
rorTrace for 64 bit systems) 

3. Create a new DWORD registry variable for 
MaximumDiskspaceUsageMB, set to the appropriate value in Mb. 

4. Close the Registry Editor 
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Option Default 
Value 

Description 

TotalDaysToKeepFiles N/A This registry value maintains the number of days the old component level 
logs are kept by the Perceptive Intelligent Capture server. Setting this value 
to “0” has the same effect as if the value is not created at all, which is 
“deactivated”. 

 

To configure the ASE pool to return additional likely results, complete the 
following steps: 

1. Launch Registry Editor 

2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE 
\Perceptive\ErrorTrace (or 
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Perceptive\Er
rorTrace for 64 bit systems) 

3. Create a new DWORD registry variable for TotalDaysToKeepFiles, set 
to the appropriate value in numeric (total days to maintain logs – the 
screenshot below shows 7 days). 

4. Close the Registry Editor 

 

 

 
 

 

 



 

Percep t i ve  In te l l i gen t  Cap tu re  Ins ta l l a t ion  and  Se tup  Gu ide  

Page 113 of 2 

Index 
Account/Group Names 

Recommended ............................................. 79 

Adding 

Perceptive Intelligent Capture components .. 36 

ASP.NET 

Configuration for IIS 6.0 ............................. 47 

Before configuring ............................................ 80 

Cairo ................................................................. 28 

Cairo directory .................................................. 80 

Cedar Workflow History Wrapper Component . 33 

Checking 

Installation .................................................... 35 

Checklist 

Installation .................................................... 22 

Configuration 

ASP.Net for IIS 6.0 ...................................... 47 
Core Hardware and Sofware .......................... 8 
Hardware sizing .............................................. 9 
IIS 6.0 ........................................................... 45 
IIS 7.0 ........................................................... 49 

DAC .................................................................. 78 

Database 

Configuration ................................................ 55 
platforms ......................................................... 8 

DCOM ................... 11, 12, 13, 14, 15, 16, 17, 19 

Delete 

Demo file ...................................................... 80 

Directory contents ............................................ 28 

Discretionary Access Control ........................... 78 

Discretionary Access Control Model ................ 78 

DLLs ................................................................. 22 

Domain user ..................................................... 80 

Executables .................................................... 28 

Firewalls ........................................................... 21 

Hardware key ................................................... 80 

Heap Resources 

multiple instances ......................................... 53 

Heap Size 

multiple instances ......................................... 53 

IIS 6.0 

Configuration ................................................ 45 

IIS 7.0 

Configuration ................................................ 49 

IIS 7.5 

Windows 2008 64bit R2 ............................... 52 

Languages 

Enabling ....................................................... 89 

Licensing .......................................................... 91 

Multiple RTS instances .................................... 53 

Network Infrastructure ....................................... 8 

Novell ............................................................... 33 

NTFS .................................................... 75, 76, 77 

OCR Performance 

Maximizing ................................................... 21 

Operating Systems ............................................ 7 

Optional Components 

Install ............................................................ 27 

Peer-to-Peer networking .................................. 33 

RBAC ............................................................... 78 

Registration problems ...................................... 35 

Removing 

Perceptive Intelligent Capture components . 36 

Repairing 

The installation ............................................. 36 

Role-based Access Control ............................. 78 

Role-Based Access Control Model .................. 78 

RTS Remote Administration MMC ................... 21 

 



 

Percep t i ve  In te l l i gen t  Cap tu re  Ins ta l l a t ion  and  Se tup  Gu ide  

Page 114 of 2 

Runtime Service Manager 

Configuring ................................................... 80 

Service Packs 

Installing ....................................................... 37 

Shared Permissions ......................................... 77 

Single Sign-On Authentication ......................... 61 

SQL Server 

Checklist ....................................................... 24 
Hardware Estimate ................................. 12, 16 
Windows Authentication ......................... 24, 29 

Standalone Implementations 

Installing ....................................................... 34 

Uninstalling 

Current Version ............................................ 36 
Previous versions ......................................... 25 

Web.Config 

Decryption .................................................... 58 
Encryption .................................................... 58 
Location ........................................................ 28 
Options ......................................................... 93 

Windows 7 ......................................................... 7 

Windows Authentication 

configuration ................................................. 62 
IIS 6 .............................................................. 63 
IIS 7 .............................................................. 63 
SQL Server ................................................... 24 
web.config .................................................... 68 

Windows Server 2008 ........................................ 7 

Windows Workgroup ........................................ 33 

Windows XP ............................................... 19, 20 

 

 


	Table of Contents
	About Perceptive Intelligent Capture
	System Requirements
	Operating Systems
	Perceptive Intelligent Capture Database
	IIS
	Scripting components

	Hardware Requirements
	Network Infrastructure
	Hardware and Software Factors
	Hardware Estimate – 500 PPD
	Introduction – AP Project
	Hardware Estimate
	Hardware Estimate – SQL Server Database (Excl. Web Verifier)
	Hardware Estimate – Entire Application Suite
	Hardware Estimate – Typical Development Environment

	Hardware Estimate – 4000 PPD
	Introduction – AP Project
	Hardware Estimate – File System (Excl. Web Verifier & Database)
	Hardware Estimate – SQL Server Database (Excl. Web Verifier)
	Hardware Estimate – Entire Application Suite
	Web Verifier Server Hardware Sizing – Additional Information

	Infrastructure Constraints
	OCR Performance
	Firewalls

	RTS Remote Administration MMC

	Installation prerequisites of Perceptive Intelligent Capture
	Before Installing Perceptive Intelligent Capture
	Installation Checklist

	Backward Compatibility with Other Perceptive Applications
	Perceptive Intelligent Capture License File
	Perceptive Intelligent Capture Database Checklist
	Perceptive Intelligent Capture Database
	Perceptive Intelligent Capture SQL Server Checklist
	Perceptive Intelligent Capture ORACLE Checklist

	Upgrade from Previous Versions
	Perceptive Intelligent Capture Versions 1.3.x and 2.x
	Upgrade from Version 5.3 or later versions
	Upgrade from versions prior to 5.3

	Remove Perceptive Intelligent Capture Versions 3.0, 4.0, and 4.1

	Install Perceptive Intelligent Capture
	Software Installation
	Select Custom Installation
	Program Folder and Auto Update
	Finish Typical and Custom Installations
	Perceptive Intelligent Capture Database Setup
	Complete the Perceptive Intelligent Capture Setup

	Manually Create Database Objects (post install)
	Configure the Perceptive Intelligent Capture database (post install)
	Cedar Workflow History Wrapper Component
	Install Perceptive Intelligent Capture in a Workgroup Configuration
	Install Perceptive Intelligent Capture in Standalone Mode
	Check the Installation
	Migrate Existing Project Files to Version 5.6
	Remove Perceptive Intelligent Capture Version 5.6
	Repair a Perceptive Intelligent Capture Version 5.6 Installation
	Add or Remove Version 5.6 Components
	Install Perceptive Intelligent Capture Service Packs and Service Updates
	Current patch level

	Password Encryption for Database Connection Strings in Core Config Files
	INI File Encryption
	INI File Encryption for Project Developer
	INI File Encryption for Integrator

	Silent Installations
	Silent Install.ini

	Prepare Internet Information Server (post install)
	Configure IIS 6.0
	Configure Web Verifier in IIS 6
	Configure IIS 7.0
	Configure Web Verifier in IIS 7
	Windows 2008 64bit R2
	IIS 6.0 Metabase Configuration - MetaBase.xml

	Run Multiple Web Verifier and RTS instances

	Configure Application
	Configuring Application
	Configure Perceptive Intelligent Capture Database connection string
	Set path to license file
	Enable HTTP compression for IIS 6.0 and IIS 7.0

	Server Security Configuration
	Register COM components
	Prepare the User Context

	Set Permissions for Perceptive projects execution
	Encrypt sections with aspnet_regiis tool

	Client Security Configuration
	Configure Single Sign-On Authentication for Web Verifier
	Enable Single Sign-On Authentication
	SSO Session vs. Web Verifier Client Session

	Configure Windows Authentication for Web Verifier
	For IIS 7
	For IIS 6
	Changes to Web.config File
	Revert Back to Standard Authentication

	Configuring SSL for Web Verifier
	Configure Additional Languages
	Virus Check
	Enable New Columns for Batch View
	Change Custom Column Names
	Custom Column Names for Web Verifier
	Custom Column Names for Thick Verifier Client
	Global Application Setting Configuration



	Security
	Perceptive Intelligent Capture Security
	Project Security
	Project & Windows Authentication Security

	File System Security
	Access to Project Data
	Accounts and File Access Security
	Configure the Service Account for Perceptive Intelligent Capture
	Run Perceptive Intelligent Capture on a Domain Network
	System Monitoring
	Email Import and Service User Accounts


	Configure Runtime Components
	Before Configuring Components
	Configure the Runtime Service Manager
	Configure the RTS RemoteAdmin MMC Snap-in
	Configure E-mail Import
	Advanced Logging
	System Resource Logging
	Crash / Failure Logging


	Auto-Update
	Description
	How the Automatic Update Works
	Configure Auto Update in Perceptive Intelligent Capture Setup
	Manual Configuration of the Auto Update Function
	Edit the “AutoInstall.bat” Batch File
	Change Shortcuts


	Usage

	Enable Additional OCR Engine Languages
	To Enable a Language for an OCR Engine
	To add Input Language for Windows 7
	To add Input Language for Windows XP
	To add Input Language for Windows Vista
	To add Input Language for Windows 2008
	To add Input Language for Windows 2003

	Use Perceptive Intelligent Capture Licenses
	Appendix A Web.Config Options and Associated Resource File Parameters
	Appendix B File Permission Matrix
	Appendix C Registry Options
	Index

